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READ ME FIRST

Welcome to Take Control of Maintaining Your Mac, version 1.0.

Macs, like all machines, are prone to break down eventually—in either
a physical sense (a component going kaput) or a logical sense (files
becoming corrupted, applications misbehaving). You can reduce the
risk of such problems, and minimize the damage when they do occur,
with a regular maintenance regimen. This ebook contains simple,
practical steps you can take to keep your Mac humming.

This ebook was written by Joe Kissell, edited by Caroline Rose, and
published by TidBITS Electronic Publishing.

To get in touch or learn more about us, you can:

« Contact us by sending email to tc-comments@tidbits.com.

« See About This Ebook to learn about the author and publisher.
« Read the fine print on the copyright page.

- Find answers to general questions by reading the FAQ at
http://www.takecontrolbooks.com/faq.html.

« Buy another ebook by checking out our Featured Titles or visit
http://www.takecontrolbooks.com/catalog.html.

The price of this ebook is $10. If you want to share it with a friend,
please do so as you would with a physical book, meaning that if your
friend uses it regularly, your friend should buy a copy. The Help a
Friend button on the cover makes it easy for you to give your friend
a discount coupon.

We may offer free minor updates to this ebook. Click the Check for
Updates button on the cover to access a Web page that informs you
of any available or upcoming updates. On that page, you can also
sign up to be notified about updates via email.
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Onscreen Reading Tips

We carefully designed the Take Control ebooks to be read onscreen,
and although most of what you need to know is obvious, note the
following for the best possible onscreen reading experience:

Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links,
as are URLs and email addresses.

Work with the Bookmarks tab or drawer showing so that you can
always jump to any main topic by clicking its bookmark.

In Adobe Acrobat Pro version 6 or 7, set your preferences to view
Web URLs in a Web browser: choose Acrobat > Preferences,
switch to the Web Capture pane, and choose In Web Browser from
the Open Web Links pop-up menu.

Find more tips in the Take Control FAQ on the Web.

Printing Tips

Although our layout is aimed at making online reading an enjoyable
experience, we’ve made sure that printing remains a reasonable
option. Please review these tips before you print:

Use the Check for Updates button on the cover to make sure you
have the latest version of the ebook and to verify that we don’t plan
to release a new version shortly. If you want to commit this ebook
to paper, it makes sense to print the latest possible version.

Don’t throw out your PDF after you print! You must click the
Check for Updates button on the cover to get future updates.
The link must be accessed from the cover of your PDF.

For a tighter layout that uses fewer pages, check your printer
options for a 2-up feature that prints two pages on one piece of
paper. For instance, your Print dialog may have an unlabeled pop-
up menu that offers a Layout option; choose Layout, and then
choose 2 from the Pages per Sheet pop-up menu. You may also
wish to choose Single Hairline from the Border menu.

When printing on a color inkjet printer, to avoid using a lot of
color ink (primarily on the yellow boxes we use for tips and
figures), look for an option to print entirely in black-and-white.
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« In the unlikely event that Adobe Acrobat or Adobe Reader cannot
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.

Basics

In reading this ebook, you may get stuck if you don’t know certain
basic facts about Mac OS X, or if you don’t understand Take Control
syntax for things like working with menus or finding items in the
Finder. Please note the following:

« Path syntax: This ebook occasionally uses a path to show the
location of a file or folder in your file system. Path text is formatted
in bold type. For example, Mac OS X stores most utilities, such as
Terminal, in the Utilities folder. The path to Terminal is:
/Applications/Utilities/Terminal.

The slash at the start of the path tells you to start from the root
level of the disk. You will also encounter paths that begin with ~
(tilde), which is a shortcut for any user’s home directory. For
example, if a person with the user name joe wants to install
fonts that only he can access, he would install them in his
~/Library/Fonts folder, which is just another way of writing
/Users/joe/Library/Fonts.

« Menus: When I describe choosing a command from a menu in
the menu bar, I use an abbreviated description. For example, the
abbreviated description for the menu command that creates a new
folder in the Finder is “File > New Folder.”

« Finding preference panes: I sometimes refer to systemwide
Mac OS X preferences that you may want to adjust. To change
these settings, open System Preferences by clicking its icon in
the Dock or choosing System Preferences from the Apple menu.
Settings are categorized into topic-specific preference panes. You
access a particular preference pane by way of its icon or the View
menu. For example, to see “the .Mac preference pane,” you would
launch System Preferences and then click the .Mac icon or choose
View > .Mac.
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INTRODUCTION

A couple of years ago, I went to the dentist for the first time since the
late 1990s. The main reason I’d failed to make dental appointments
was embarrassment at having waited so long. I could just hear the
dentist chiding me, “Ah, I can see you haven’t had your teeth cleaned
properly in 5 years. For shame!” The more time passed, the worse the
embarrassment grew, and finally it took actual pain and a visible hole
in a tooth to overcome it. So I was disappointed, but not surprised, to
learn that I had several cavities and needed a root canal. The dentist
was kind and understanding, but nevertheless pointed out several
times that this visit might have been much less painful (and less
expensive) had I flossed every day and gone for my semiannual
checkups as I knew I should have.

I tell you this story not merely to urge proper dental hygiene, but
because maintaining your Mac—like maintaining your teeth, your car,
your health, or your home—is a good habit whose rewards are having
fewer problems later on and being able to recover more easily from
problems that do arise. You can sometimes get away without doing
any maintenance for a few months or perhaps much longer, but you
risk losing data, wasting time, and having to spend a great deal of
money repairing or replacing your computer.

This ebook teaches you the most important and useful maintenance
tasks you should perform to increase your chances of keeping your
Mac in tip-top operating condition throughout its lifetime. I've
organized the tasks according to their frequency: what you should do
daily, weekly, monthly, and yearly, as well as some important initial
steps, some things you should do when a Mac OS X upgrade appears,
and some tasks you might want to avoid, contrary to conventional
wisdom. If you follow these recommendations diligently, you’ll
dramatically decrease the likelihood of serious problems.

I want to make a few disclaimers up front. First, there’s no such thing
as the One True Way to maintain your Mac. Everyone’s situation is
unique, so you may need to adapt these instructions to suit your
needs—perform certain tasks more often or less often, skip tasks that
don’t apply to you, and so on. Take these instructions as guidelines,
as a starting point to determine your own maintenance regimen.
Second, no amount of maintenance can guarantee that you’ll never
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have any problems. Manufacturing defects, malfunctioning software,
user errors, and other mishaps can and do occur. Proper maintenance
should, however, minimize both the number and the severity of
problems you experience. Finally, this ebook does not cover trouble-
shooting or repair; the focus is on preventing problems, not fixing
them. If your Mac crashes, loses data, fails to start up, or otherwise
behaves improperly, you'll need to look elsewhere for solutions.

(I recommend some places to look in Appendix A: Troubleshooting
Resources.)

NoTE To reflect the diversity of opinion about certain maintenance tasks,
I've included several sidebars containing brief conversations among
Mac experts, some of whom are Take Control authors or editors.

These discussions are based on comments made on a preliminary
draft of this ebook.

Although I wrote this ebook based on Mac OS X 10.4 Tiger, most of
the information applies equally well to earlier versions of Mac OS X.
However, note that one of the first suggestions I make is to upgrade
your Mac, if possible, to run the latest version of Mac OS X, which is
likely to contain fewer bugs than earlier versions.

The tasks in this ebook are easy, and they get easier the more you do
them. So start developing those good maintenance habits right now.
And don’t forget to floss every day!
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QUICK START

This ebook describes a step-by-step process for maintaining your
Mac. The maintenance intervals (daily, weekly, monthly, yearly)
reflect the relative urgency of the tasks in each section; you may
choose to do the tasks within a section in any order, but I strongly
suggest first following the steps in Start on the Right Foot.

Get ready:

« Get your Mac into the best possible shape by updating your
software, getting rid of old files, setting up a backup system, and
performing other preliminary tasks. Read Start on the Right Foot.

Perform periodic maintenance tasks:

« Every day, update your backup archive and download (but don’t
necessarily install) software updates. See Perform Daily Tasks.

« Once a week, perform maintenance such as cleaning up your
Desktop, backing up your hard drive, installing software updates,
and rebooting or clearing certain caches if you notice performance
problems. See Perform Weekly Tasks.

« Once a month, empty your Trash, check your disk for errors, do
some light cleaning, and exercise your notebook’s battery. See
Perform Monthly Tasks.

« Once a year, give your Mac a good spring cleaning inside and out;
make extra backups for long-term storage, get rid of extraneous
files, and change your passwords. See Perform Yearly Tasks.

Save time by skipping unnecessary work:

« Learn why you can probably avoid two common maintenance
tasks. Read Things You Might Never Need to Do.

Handle Mac OS X upgrades with ease:

« Before you know it, Apple will ship the next major upgrade to Mac
OS X. Learn what you need to know to be ready for it in When a
New Version of Mac OS X Is Released.

Avoid or fix problems:

« Catch hardware and software problems before they become
serious, or troubleshoot them if they do happen. See Monitor Your
Mac’s Health and Appendix A: Troubleshooting Resources.
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START ON THE RIGHT FooT

Whether you've just unpacked a shiny new Mac or you're hoping to
get an older machine into shape, your first step should be to perform
some initial cleanup and preparation tasks. These steps will help your
Mac run better right now, and will make ongoing maintenance tasks
easier.

Install the Latest Version of Mac OS X

If your Mac is already running the latest and greatest version of Mac
OS X, good for you! Skip to the next section. If not, your first step
should be to upgrade.

Every release of Mac OS X includes dozens if not hundreds of bug
fixes to prevent crashes or other errors and to patch holes that ne’er-
do-wells might use to damage or gain access to your system. That
fact alone is reason enough to keep up to date. In addition, Apple
constantly introduces useful new features, and some newer software
runs only on recent versions of the operating system. Often, doing
nothing more than updating your system software can eliminate

a wide range of problems—and prevent others.

Mac OS X updates fall into two categories: major and minor. Major
updates (more properly known as upgrades) increment the digit after
the first decimal point in the version number: 10.2, 10.3, and 10.4
were all major updates. With rare exceptions, Apple charges money
(typically $129) for major updates. Minor updates increment the digit
after the second decimal point: 10.4.2, 10.4.3, and 10.4.4 were all
minor updates. Minor updates are always free.

Without exception, you should download and install every minor
update. (I do, however, suggest waiting a few days after an update
appears to make sure it doesn’t contain any serious errors; see
Download Software Updates, later.) The easiest way to do so is to
use Software Update (see Turn On Software Update, next). Major
upgrades are less urgent, because they focus primarily on new
features. But because they also fix numerous bugs, you should
consider buying and installing them. Read When a New Version
of Mac OS X Is Released, later, for details.
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Some Macintosh users, having heard horror stories of half-baked
releases that cause as many problems as they fix, feel anxious every
time a software update appears. I won't lie to you: major errors
occasionally sneak into system updates. But this happens rarely, and
in most cases Apple resolves such problems promptly. In addition, a
fair number of errors that appear to be update-related are in fact the
result of existing problems on the user’s machine, minor issues such
as incorrect permissions, or even (gasp!) user errors. I can’t guarantee
that a software update will never break anything, but in my experi-
ence the benefits of incremental updates overwhelmingly outweigh
the risks—especially if you maintain good backups (see Set Up a
Backup System).

Turn On Software Update

Mac OS X includes a feature called Software Update, which checks
Apple’s servers periodically to see if free updates exist for any Apple
software on your computer, and, if so, offers to download and install
them for you. Software Update is the easiest way to keep your Mac
up to date with bug fixes and minor enhancements, and I strongly
recommend that you use it.

NoTE I want to reiterate that Software Update handles only Apple software
(including Mac OS X as well as applications such as iLife, iWork,
Logic, and Aperture). To learn how to update third-party software,
see Update Third-Party Software, next.

Software Update is enabled by default, but you should check to see
that it’s still on and that its options are configured optimally. To set
up Software Update, follow these steps:

1. Go to the Software Update pane of System Preferences (Figure 1).

2. Make sure the Check for Updates checkbox is checked. Then, from
the pop-up menu, choose how often Software Update should run:
Daily, Weekly, or Monthly. (If you have an always-on, high-speed
Internet connection, choose Daily; even if you choose not to install
an update immediately, you’ll know about it as soon as possible.)

3. If you have a fast Internet connection and plenty of disk space,
check Download Important Updates in the Background. This
causes Software Update to download things like Mac OS X updates
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and security updates as soon as it sees them. You still get to choose
whether or not to install them, but when you do choose, you don’t
have to wait for the download to complete—the files are there,
ready to go.

FIGURE 1

@8 C Software Update
| | | Show All | Q

_f Update Software | Installed Updates

Software Update checks for new and updated versions of your software based on
information about your computer and current software.

W Check for updates: ~ Daily 44

@ Download important updates in the background
You will be notified when the updates are ready to be installed.

Check Now

Last check: Software Update ran successfully.
1/28/06 3:15 PM

Configure Software Update settings in this preference pane.

4. To perform an immediate check, click Check Now. Software
Update informs you if any new software is available. (You can also
check for updates at any time by choosing Software Update from
the Apple menu.)

5. Close System Preferences.

At the interval you set, Software Update checks for new software.
When it finds some, it displays a dialog in which you can select any
or all of the updates for immediate installation, defer them to a later
time, or remove items from the list entirely. For complete details,
read Use Software Update to Install Apple Software Updates.
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SIDEBAR SOFTWARE UPDATE vS. MANUAL UPDATES

In general, software packages that Apple makes available through
Software Update are also available on the company’s Web site, so you
can download them manually if you wish (http://www.apple.com/
support/downloads/).

Starting with the second minor release of each Mac OS X version—
such as 10.4.2 for Tiger—Apple typically produces three separate
updaters: the updater available only through Software Update,
known as a “patch” or “smaller-sized delta” updater; the standard
(or “regular-sized delta”) updater; and the “combo” updater. Delta
updaters require the most recent previous release to be installed;
for example, a 10.4.6 updater would require that 10.4.5 already h
be installed. A combo updater, on the other hand, will update any
previous version of the major system release (in this example, any
release from 10.4.0 through 10.4.5) to the new version. Because of
this, combo updaters are always larger—in some cases much larger.
Software Update chooses the smallest applicable updater, which
means it chooses the smaller-sized delta updater if you run Software
Update regularly.

Why should you care? Well, on a few occasions, users have found
that using the delta updaters (whether manually or via Software Up-
date) for some reason left out essential files that prevented proper
operation of some Mac OS X features, whereas these files were
included when the same users applied the combo updater. Although
I've never had problems with the delta updaters, anecdotal evidence
suggests that you may have a slightly lower risk of problems if you
manually download the combo updater for each Mac OS X update
instead.

Update Third-Party Software

Software bugs are a fact of life, but in general, applications improve
with each release. You can avoid, or solve, many maintenance prob-
lems simply by making sure you have the latest version of every
program installed.
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NoTE In some cases, getting the latest version of a program means spend-
ing hundreds of dollars on a major upgrade. In cases where you can’t
afford the absolutely latest version, you should at least install the
latest free update you can find. This may require some searching on
the company’s Web site; earlier updates may not be featured as
prominently as the most recent update.

Because Software Update handles only Apple software, any other
developer wanting to offer similar capabilities must devise a separate
update mechanism. Happily, almost every major application (and a
good percentage of minor ones) contains some sort of update feature.
Unhappily, they don’t all work the same way. Some of them check for
updates on a schedule, while others don’t—and of those that do, not
all have this feature turned on initially. Some programs can download
and install new versions of themselves automatically, while others
simply download a disk image and expect you to open it and run the
installer yourself; still others do nothing but open a Web page with
links to updates you can download manually.

In an ideal world, updates would require no intervention other than
a single click to confirm that you're aware of, and approve of, the
installation; everything else would happen automagically. Because
only a few applications currently offer that level of automation,
though, you may have to perform some extra steps.

I describe how to handle ongoing updates ahead in Download
Software Updates and Check for Third-Party Software Updates.
For now, do just two things:

« Make sure all your software is up to date. In each
application that you use frequently, look for a Check for Updates
command (the wording may vary). Such commands usually appear
in the application menu (the one bearing the application’s name),
the Help menu, or the Preferences dialog. If you can’t find such
a command, visit the developer’s Web site.
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Tip Don’t forget to check for updates of preference panes, menu extras,
plug-ins, Dashboard widgets, and other system enhancements. These
types of software frequently lack an automatic update feature.

« Turn on any automatic software update features your
applications may have. Again, check each application’s
Preferences dialog for a checkbox that enables scheduled updates,
and if you can choose how often to check, choose the most fre-
quent option.

GRIPE Some applications check for updates every time you launch them,
and display an intrusive alert after each check just to tell you that no
updates are available. Ugh! An alert of that sort should appear only
after a manual check for updates. In such cases, I either turn off
automatic checking or change it to a weekly or monthly check.

Clean Out Accumulated Cruft

The term “cruft” is hacker slang for digital detritus—obsolete, extra-
neous, or otherwise useless files that have accumulated on your disk
over time and now do nothing but take up space. By removing cruft,
you can recover valuable disk space, increase the speed of backups,
file searches, upgrades, and disk diagnostics, and reduce the chance
of software conflicts.

NoTe This step may not apply to you if you have a brand-new Mac, but even
a few months of use can generate a surprising amount of cruft.

Determining which files you need and which files can go may be

a nontrivial undertaking. Some files (2006 tax deductions.xls” or
“Take Control of Maintaining Your Mac.pdf”) are obviously impor-
tant, and some (caches, old downloads, and so on) are obviously
disposable. In between you may find thousands of files that you
can’t identify and that may or may not have some value.

My advice is to work slowly and deliberately, and avoid deleting
anything whose purpose you’re uncertain about. In particular—with
a few exceptions I'll mention shortly—you should be circumspect
about deleting items in /Library, and almost never delete anything
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in /System. And remember: do this to reduce clutter, not as a matter
of life and death. So don’t be too ruthless when it comes to deleting
your files.

Tip Because you're about to delete files, I strongly recommend that you
make a full backup first, in case you accidentally delete something
important. See Set Up a Backup System and Back Up Everything.

Here are my suggestions for files you might consider deleting;:

« Your ~/Documents folder is a likely place for unneeded files.

Skim the contents of this folder and its subfolders, looking for
documents and application support files you no longer need,
and drag such items to the Trash.

Tip Numerous programs make automatic backups of their files. This is a
good thing, but over time you might accumulate dozens or hundreds
of old, large backup files that do you no good. BBEdit and MYOB
AccountEdge are among the known culprits.

In addition, if you save iChat transcripts (in ~/Documents/iChats),
you might also wish to delete old ones. And Eudora users may want

to look through ~/Documents/Eudora Folder/Attachments
Folder for unneeded attachments.

Look in /Applications (and /Applications/Utilities)
for any software you’ve installed over the past year but never use.
(Expired demo software, anyone?) Resist the temptation to delete
Apple software that came with Mac OS X, though; you may need
it later.

In /Library, /Library/Application Support, ~/Library,
and ~/Library/Application Support, look for folder names
matching applications you no longer use, and delete them.

Your /Library and ~/Library folders may contain other
folders that store components of third-party utilities. Look

in Application Enhancers, Bundles, Contextual Menu Items,
InputManagers, and PreferencePanes for any system enhance-
ments you no longer use, and drag them to the Trash.
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Third-party Dashboard widgets live in ~/Library/Widgets. Any
widgets you don’t use can go.

Software that requires some component to be running in the
background all the time may install folders in /Library/
StartupItems. In most cases, you should leave this folder alone,
but if you see anything there from software you’re sure you don’t
use, delete it.

WARNING! The /Library/StartupItems folder often holds background
software you need but weren’t aware you needed. For example,
StickyBrain and SOHO Notes use an item in this folder called
OpenBase; Retrospect uses a folder called RetroRun; and Now
Up-to-Date & Contact uses a folder called NUDC. In short, if
you’re uncertain about anything in this folder, don’t touch it.

Kernel extensions (files with names ending in .kext) add low-level
functionality to Mac OS X. Examples include hardware drivers (for
devices such as mice, trackballs, and audio interfaces), encryption
tools, and screen-capture software. These files are stored in either
/Library/Extensions or /System/Library/Extensions.
Any such software you no longer need can be deleted, but be very
careful, especially in /System/Library/Extensions: most of
these files are essential to Mac OS X, and that includes some that
may have a third-party company in their name. If you see any
obsolete items in one of these folders, the safest way to remove
them is to run the installer that put them there in the first place
and choose Uninstall (or follow uninstallation instructions
provided by the developer). Do not delete them manually.
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TiP UNINSTALLER UTILITIES

If you prefer not to muck around in your Library folders looking for
individual files to delete, consider picking up a utility that can do all
the hard work for you. Here are some examples:

« Spring Cleaning: This utility from Allume can find and remove
all sorts of cruft, including empty folders, orphaned aliases,
Internet caches, and of course ordinary applications and their
supporting files. Among the many tricks up its sleeve is the ability
to restore items it has deleted if you later realize that you need
them.
http://www.allume.com/mac/springcleaning/ ($50)

« AppZapper: A much simpler tool, AppZapper does just one
thing (and does it well): it removes all the pieces associated with
a given application, including preference and cache files, items
in your Application Support folders, and even installer receipt
files.
http://www.appzapper.com/ ($13)

I should also mention two utilities that don’t make any attempt to

uninstall software but simply help you identify and delete large files

on your drive that you may not need:

« OmniDiskSweeper
http://www.omnigroup.com/applications/omnidisksweeper/
($15)

« WhatSize
http://www.id-design.com/software/whatsize/ (free)

When you're finished deleting files, be sure to empty the Trash
(Finder > Empty Trash) to recover the space the files previously
occupied.
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SIDEBAR A CONVERSATION ABOUT REMOVING CRUFT

How important is it to remove extraneous files? These experts
expressed a variety of opinions:

Kirk McElhearn: One thing I do is remove language files (using
Monolingual, http://monolingual.sourceforge.net/) every once in a
while. It saves a bit of disk space and makes backups a little faster.

Glenn Fleishman: I think advice to remove cruft is very 1990s.
There’s little reason, except for backup storage issues and local
storage issues, to ever delete a document. Movies and pictures may
need extra storage or culling, but between Spotlight searching and
giant hard drives, why delete? Backups are only marginally slower
with a greater number of small files, so the advantage in deleting
them is minimal.

Kirk McElhearn: You can save over 1 GB by deleting language
files, and this allows you to make a clone on a smaller partition for
backups.

Joe Kissell: I don’t delete language files myself, because I have
plenty of disk space and I don’t like to muck around with applications
unnecessarily. However, to Glenn’s point, I think removing cruft is
valid even if you have tons of disk space, and Spotlight searching is
in fact a great example of why I think that: when I'm looking for a file,
I don’t want to have to wade through a long list of matches, most of
which are irrelevant items I could have deleted. And backups may
not take much longer if you're backing up to another hard disk, but

if you're backing up to optical media or a network server, every extra
gigabyte has a significant impact.

Tonya Engst: I think it depends on the person. For example, I hate
to keep extra email. It bothers me to have crufty mailboxes. Adam,
on the other hand, prides himself on keeping all the email he’s ever
received, even the spam. Of course, if ’'m missing something there’s
a good chance Adam has it, so I can get away with being a little trig-
ger happy on the Delete command. I think it’s OK for people to figure
out whether they’re pack rats or not, and to behave accordingly. I
have found, though, that the better my filing scheme, the more files

I keep. What I hate are files whose purpose or contents I can’t easily
identify. It’s like someone else (perhaps Apple) putting real clutter
on my real office shelves.
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Turn Off Unneeded Login Items

Mac OS X can run applications or open files automatically when any
given user logs in; items set to open in this way are called login items.
(Under Mac OS X 10.3 Panther, Apple called them startup items.)
You can add a login item manually—for example, to save yourself

a click or two by making sure your email program or Web browser
runs every time you log in. Numerous applications also install login
items—often without advertising that fact—so that background ser-
vices they rely on are always available. Examples of programs that
install background-only login items are iCal, Microsoft Office,
Quicken, StickyBrain, and Stufflt Deluxe.

Login items are useful, but they can also increase the time it takes to
start your Mac (or switch users). In addition, the more applications
you have running at once, the greater your RAM usage and CPU load.
So I recommend checking to make sure you don’t have any login
items you can do without.

To check your login items, follow these steps:
1. Go to the Accounts pane of System Preferences.

2. Select your account in the list on the left and click the Login Items
button (see Figure 2).

3. Scan the list of login items for any you no longer use. If you find
one, select it and click the [~ button. (This removes the item from
the list but does not delete the corresponding file from your disk.)
Repeat as necessary.

Tip If you hover your mouse pointer over an item in the Login Items list
for a couple of seconds, a yellow tool tip appears with that item’s
complete path. This information may not tell you exactly what the
item does, but it at least tells you where it is, which may provide
important clues.
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FIGURE 2 8 Accounts
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In the Login Items view, look for login items you no longer need
and remove them.

NOTE You may find a few unfamiliar items in the Login Items list that are
nevertheless legitimate and useful. In particular, do not remove
these, if present:

- iCalAlarmScheduler: Enables iCal to display alarms even when
the application is not running.

« iTunesHelper: Watches for an iPod being connected or discon-
nected, to help iTunes communicate with it.

« Microsoft AU Daemon: Schedules automatic updates for
Microsoft Office applications.

« System Events: Enables AppleScript (or applications based on
AppleScript) to send commands to parts of the operating system.
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Set Up a Backup System

No amount of maintenance can guarantee that your hard drive will
never crash, that your Mac will never be stolen, or that lightning will
never hit your house. Any number of catastrophes could potentially
imperil your computer—and its data. Of course, you can replace a
computer, but what about your email, photographs, music collection,
tax records, and all the other important information on your hard
disk? To keep your data safe, you need good backups. If you've never
taken the time to set up a proper backup system, the time is now!

I wish I could tell you that backing up your computer is a simple
matter of clicking a few buttons. But there’s more to it than that:
understanding the various types of backup, choosing backup hard-
ware and software that has all the features you need, configuring your
system, storing backup media safely, and many other details. The
good news, though, is that once you've set up a backup system, it
should run happily with little intervention for months or years.

Because so much can be said about backups, I've written an entire
ebook on the subject: Take Control of Mac OS X Backups
(http://www.takecontrolbooks.com/backup-macosx.html). If you
have any doubts or questions about backing up, I recommend giving
it a read. I think you’ll find it to be time (and money) well spent.

Although I can’t cover everything in the Backups ebook here, I can
give you a brief summary. For the best compromise among data
safety, cost, and ease of use, I recommend the following:

« Obtain a full-featured backup application, such as EMC Dantz’s
Retrospect Desktop (http://www.dantz.com/en/products/
mac_personal/index.dtml; $129), Prosoft’s Data Backup
(http://www.prosofteng.com/products/data_backup_info.php;
$59), or Intego’s Personal Backup X4 (http://www.intego.com/
personalbackup/; $70).

« Use your backup application to store an archive of all your
important files (and if you can afford the space, archive the
unimportant ones too). Update this archive every day with files
that are new or have been modified since your last backup—
without deleting the old files in the archive.
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« On a second partition of the backup drive (or on another external
drive), make a bootable duplicate (a “clone”) of your entire hard
disk onto an external FireWire drive and update it at least once
a week. All the previously mentioned backup applications can
make duplicates as well as archives. Some applications make
duplicates but not archives; of these, I suggest either SuperDuper!
(http://www.shirt-pocket.com/SuperDuper/; $28) or Carbon
Copy Cloner (http://www.bombich.com/software/ccc.html; free,
donations accepted).

« If possible, schedule your backup software to update archives and
duplicates automatically (at least daily for archives; at least weekly
for duplicates).

« Funds permitting, maintain two or more sets of backup media.
Be sure to store one of these sets offsite—that is, in a building other
than the one where you normally keep your computer—rotating
the sets every week or so.

Needless to say, you can back up your computer in many other ways,
and I explore a wide variety of options—and why they may or may not
be appropriate for different kinds of users—in my Backups ebook. But
one way or another, get a backup system in place right now. Later on
in this ebook, I reiterate important backup tasks: Back Up Changed
Files (daily); then Back Up Everything and Rotate Backups Offsite
(weekly). If you set everything up now, you’ll breeze through those
periodic tasks, almost without noticing them.

Run Apple Hardware Test

When you purchased your Mac, the box should have included a CD
or DVD with an application called Apple Hardware Test. Depending
on when you bought your computer, this could be an independent
disc, or it may be included on the Mac OS X Install Disc. (Look for
tiny lettering on the disc that says “To use Apple Hardware Test, hold
down the Option key as the computer starts up,” or words to that
effect.) Find this disc now. (I'll wait while you root through your attic
or basement to find it hidden in the bottom of a box somewhere.)

Back already? Super. You have in your hands a very special program.
Apple Hardware Test can run only when you start up from the CD or
DVD it came on; don’t bother trying to copy it to your hard disk. This
program performs a series of diagnostic tests on your Mac’s hard-
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ware, including the AirPort card, logic board, hard drive, RAM,
modem, and video RAM. It doesn’t repair anything, and it doesn’t
look for problems such as directory errors that are the province of
Disk Utility (see Run Disk Utility, next). But it can identify subtle
hardware defects that could later lead to serious problems. Whether
your Mac is fresh out of the box or years old, you owe it to yourself to
make sure its major components are in good health, and this is the
easiest (and cheapest) way to do so.

NoTE Apple Hardware Test isn’t the only tool that can check your RAM.
Among the other utilities that can do this are TechTool Pro
(http://www.micromat.com/tt_pro_4/tt_pro_4.html; $98) and
Rember (http://www.kelleycomputing.net:16080/rember/; free).
I've personally had bad RAM that Apple Hardware Test could
identify while these others could not, whereas other Take Control
authors have had the opposite experience. Your mileage may vary!

To run Apple Hardware Test, follow these steps:

1. Insert the disc with Apple Hardware Test on it into your Mac and
restart, holding down the Option key until icons appear represent-
ing the available startup volumes.

2. Click the Apple Hardware Test icon, and then click the right arrow.

3. After the program loads, select a language and click the right
arrow.

4. On the Hardware Tests tab, click Extended Test.

5. Take a nice hot bath or enjoy a stroll around your neighborhood.
This test takes a while! The screen says, “Estimated time: 10—15
minutes, or longer depending on the amount of memory installed.”
Take the “or longer” part seriously. On a fairly fast test machine
with 2 GB of RAM, the test took almost an hour and 45 minutes.

6. If all is well, the word “Passed” appears next to all the applicable
tests in the Test Results area. If not, a failure message appears;
if this happens, look in the About the Test and Results area for
advice.

7. Click Restart to restart your computer.
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I recommend running the test again after installing RAM or any other
new hardware inside your computer, or if you begin to have inexpli-
cable problems that ordinary disk utilities do not solve.

SIDEBAR BE SURE You HAVE ENOUGH RAM

The most important thing you can do to speed up your Mac and
reduce crashes is to be sure it contains enough RAM. Few new Macs
ship with what I consider “enough.” Even though Mac OS X and most
applications can run in as little as 512 MB, in my experience perfor-
mance degrades quickly with that amount of RAM when you have
numerous applications and windows open at once.

How much RAM should you have? The answer depends on the type
of Mac, the way you work, and your budget. On the one hand, I think
everyone should have at least 1 GB (or the maximum their machine
supports, if less). On the other hand, more isn’t necessarily better.
For example, only a few people running the most memory-intensive
applications would benefit from putting the maximum of 16 GB in a
Power Mac Gs5.

In general, if your Mac can hold 2 GB or less, I suggest maxing it out
(budget permitting). Go above 2 GB if you spend all day working with
heavy-duty photo, video, or audio applications, if you run high-end
scientific software that performs complex mathematical operations,
or if your computer functions as a server in a high-demand environ-
ment.

Run Disk Utility

You know the old saying: “If it ain’t broke, don’t fix it!” With com-
puters, though, things can be broken without manifesting any obvious
symptoms. You can nip many such problems in the bud with a simple
procedure that looks for, and fixes, common disk errors that can crop
up over time without your knowledge. I recommend doing this not
only as an initial step, but also monthly (see Use Disk Utility’s Repair
Disk Feature).
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To repair your disk, follow these steps:

1. Start up your Mac from media other than your regular startup disk
that also contains Disk Utility. This could be, for example:

« A bootable duplicate of your startup disk stored on an external
FireWire hard drive, a second internal drive, or a second
partition of your main disk

e A Mac OS X installation DVD or CD

« A TechTool Protégé device, to which you've copied Disk Utility
(http://www.micromat.com/protege/protege_intro.html)

NOTE You can’t repair the disk from which Mac OS X is running (or the
disk from which Disk Utility is running, if it’s not the same one); that
would be somewhat like trying to perform brain surgery on yourself.
You can, however, verify the disk (by clicking Verify Disk in Step 4)
to determine whether there are any problems that Disk Utility could
repair.

2. Run Disk Utility. (If running from a cloned hard disk, you can find
itin /Applications/Utilities. If running from a Mac OS X
installation disc, click through the language selection screen and
then choose Utilities > Disk Utility.)

3. In the list on the left side of the window, select your main startup
volume (the one you want to test), as in Figure 3.

4. On the First Aid tab, click Repair Disk.

Disk Utility looks for common errors and repairs them if possible.
Ordinarily, it displays a message saying that repairs were completed
or that no repairs were necessary. In the (rare) event that Disk Utility
encounters a serious problem it cannot solve, you may need to use a
commercial repair tool such as DiskWarrior (http://www.alsoft.com/
DiskWarrior/; $80).
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Select a volume (other than the startup volume) on the left, and
then click Repair Disk.

Make Sure Scheduled Maintenance Tasks Run

Mac OS X includes a tiny Unix utility called periodic whose
purpose is to perform a variety of cleanup tasks, such as deleting old
log files that would otherwise take up unnecessary space on your disk
and updating the index that the Unix locate command uses to find
files in the Terminal utility. The periodic utility can perform any of
three sets of tasks. Once a day, periodic is supposed to run “daily”
tasks; once a week, “weekly” tasks; and once a month, “monthly”
tasks. (These names are more or less arbitrary; if, for example, you
ran the monthly tasks every week, no harm would result.)

The periodic program doesn’t launch itself, though; running it
at the proper times is the job of another program, called 1aunchd
(under Tiger; in earlier versions of Mac OS X a utility called cron
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told periodic when to run). Apple set the launchers to run the
periodic scripts in the middle of the night, so that they wouldn’t
slow down other things your Mac might be doing. The problem is that
if your Mac happens to be off or asleep at the scheduled time (as it is
for most of us), the scripts can’t run. Tiger’s 1aunchd utility was
supposed to be smart enough to notice that it had missed a scheduled
task and run it the next time your Mac became active. Unfortunately,
as of Mac OS X 10.4.4, 1launchd is flaky: sometimes the periodic
scripts run (though possibly at completely unpredictable times) and
sometimes they don’t.

Tip To learn more about launchd, which is quite useful despite its
limitations, see an article I wrote for Macworld magazine: “Launch
Your Mac” (http://www.macworld.com/2006/01/secrets/
februarygeekfactor/).

In short, unless you leave your Mac on and awake all the time, the
periodic command needs a bit of help to do its thing. The easiest
solution is to download any of several programs that enable you to
run the maintenance scripts manually at any time or, in some cases,
to schedule them for times you know your Mac will be available. Try
one of these:

« Anacron: This utility runs the maintenance scripts whenever
they’re overdue, with no user intervention required.
http://members.cox.net/18james/anacron-tiger.html (free)

« Cocktail: Cocktail (Figure 4) provides a single, simple interface
for performing a wide range of maintenance tasks, including
running the maintenance scripts, deleting cache files and old logs,
adjusting hidden Finder, Dock, Safari, and Exposé settings, and
more. Some tasks can run on a recurring schedule.
http://www.maintain.se/cocktail/ ($15)

« Mac HelpMate: This utility can run the maintenance scripts
manually or on a schedule. It also deletes various caches, adjusts
hidden Finder and Dock settings, displays your drives’ S.M.A.R.T.
status (see Check Your Drives’ S.M.A.R.T. Status), disk usage, and
system uptime, and performs numerous other maintenance tasks.
http://www.macworkshops.com/machelpmate/ (free; donations
accepted)
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FIGURE 4
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Cocktail’s System pane has controls for running the daily, weekly,
and monthly maintenance scripts. You can also use the Pilot pane
to schedule them to run automatically.

« MacJanitor: If you want nothing more than a simple utility that
lets you run the daily, weekly, and monthly maintenance scripts
manually, MacJanitor does that nicely.
http://personalpages.tds.net/%7ebrian_ hill/macjanitor.html
(free)

« MainMenu: Like most of the other utilities in this list, MainMenu
performs a wide variety of functions, including running the main-
tenance scripts, clearing caches, and deleting log files. Unlike the
others, it puts all these commands into a single, always-accessible
menu, so that you can run any of them with a single click.
http://www.santasw.com/products.html (free; donations
accepted)

« OnyX: Another multipurpose utility, OnyX can run the mainte-
nance scripts manually (but not on a schedule), delete various
caches and log files, adjust hidden Finder, Dock, and Safari
settings, display log files, run Unix commands, and display disk
usage and system uptime, among other tasks.
http://www.titanium.free.fr/pgs/english.html (free)
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WARNING!

The utilities I list here are among dozens of tools that provide a pretty
GUI wrapper to Unix commands. With all such programs, you should
be careful not to click buttons blindly; because Unix commands can
theoretically do just about anything, you could cause damage if you
don’t know what you’re doing.

SIDEBAR

A CONVERSATION ABOUT PERIODIC MAINTENANCE TASKS

Should you worry about running the periodic maintenance tasks at
all? The experts had this to say:

Kirk McElhearn: This is one of my bugbears. In very few cases are
these routines essential and, with all due respect, I think it’s excessive
to suggest otherwise. Too many users think that these routines can
solve problems; I've never seen a case where this is true. At best—
unless you use the Llocate command—they’re placebos. They can
clean out some log files, but again, only in some cases (if you run

a server) does this make much of a difference.

Andy Affleck: The real advantage to running these tasks regularly
is the log rotation. When I ran them manually I saw some space gains
on my disk. It wasn’t huge, but it was noticeable.

Dan Frakes: I agree with what Andy said: for most users it won’t
help much, but it will clean up log files. And if the user uses
locate—or the GUI equivalent, Locator (http://www.sebastian-
krauss.de/software/#locator; free)—it’s useful to have the locate
database updated regularly.

Chris Pepper: Right, and remember, the 1locate database is as
relevant to SSH or a BBEdit shell worksheet as to Terminal.

Joe Kissell: I use 1locate all the time, so this is a big deal to me.
For what it’s worth, updating the locate database is one of the
weekly script items. All three script types (daily, weekly, and
monthly) rotate certain logs. The daily tasks also include backing up
your NetInfo database and deleting certain “scratch” files, such as
temporary files used when sending faxes. The monthly tasks include
generating reports of system usage for each user.
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Install Antivirus Software

If this ebook were about PC maintenance, one of the first steps would
have been to install antivirus software. For Windows users, malicious
software (or malware) has become epidemic in recent years, leading
to untold grief and loss of time, money, and data. Among the varieties
of malware are viruses (and their close cousins worms and Trojan
horses), spyware (programs that spy on your computer usage,
collecting sensitive personal data), and pop-up ad programs. Luckily,
very little malware runs on Mac OS X: as of the time I wrote this, I
could count on one hand the programs of this sort that have been
found “in the wild.”

Even though Mac users have been fortunate so far, we would be
wrong to assume our computers are immune to infection. Sooner or
later, someone is bound to come up with malicious software that does
serious damage to Macs, and when that happens, those with enough
foresight to have installed antivirus software will be much more likely
to continue merrily with their work while the rest of us struggle to
restore our systems. Furthermore, many kinds of malware spread via
email, so you could unwittingly serve as a carrier by forwarding
messages containing viruses to your Windows-using friends.

Your best defense is to load antivirus software—and keep it up
to date. Developers release regular updates (to handle the latest
threats), and you must be certain to configure your preferences
to download them automatically as soon as they appear.

NoTe Although having antivirus software is better than not having it, and
having up-to-date antivirus software is better still, there are no
ironclad guarantees. A particularly wily virus might still sneak by.
So you should still exercise caution, and especially avoid opening
iChat or email attachments from unknown sources.

Antivirus software available for Mac OS X includes the following;:

« ClamXav
http://www.markallan.co.uk/clamxav/ (free)

« Intego VirusBarrier X4
http://www.intego.com/virusbarrier/ ($70)
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« Norton AntiVirus
http://www.symantec.com/home_homeoffice/products/
virus_ protection/naviomac/ ($50)

Use a Surge Protector

If that AC cord coming out of your computer goes directly into a wall
socket, you're putting your Mac at the mercy of the power company,
your home’s wiring, and all the things that can go wrong in between:
brownouts, voltage spikes, lightning, you name it. Your Mac’s power
supply is pretty robust, but a single random power surge can still fry
its circuits. Even when the electricity appears to be flowing correctly,
imperceptible fluctuations in the current can cause computer
components to deteriorate more quickly than normal.

So please, take the basic precaution of using a surge protector. They
come in many shapes, sizes, and prices—some with every bell and
whistle, and some quite plain. Not all work equally well, so look for a
model with a good warranty that covers not only the protector itself
but also the equipment attached to it, in the event of a surge.

Better yet, consider buying a small UPS (uninterruptible power
supply). A UPS contains a battery with enough juice to power your
computer for anywhere from a few minutes to a few hours, along with
circuitry to convert the battery’s DC output to AC and switch over to
the battery instantly and seamlessly in the event of a power outage. If
the power goes out for more than a very brief period, the UPS sounds
an alarm so that you will know to save your work and shut down your
computer safely before the battery goes out. (Some UPS units include
software to handle automated shutdowns.) In addition to protecting
your computer from power outages, a UPS conditions the electricity
flowing through it and absorbs power surges.

My favorite UPS manufacturer is APC (American Power Conversion).
To find one of their models that suits your needs, use their product
selector at http://www.apcc.com/template/size/apc/. Other UPS
manufacturers that offer Mac-compatible software include:

« Belkin
http://catalog.belkin.com/IWCatSectionView.process?IWAction=
Load&Section_Id=76
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« MGE UPS Systems
http://www.mgeups.com/selector/ups/index.php?lang=us

+ Xantrex
http://www.preparedwithpower.com/backup/

SIDEBAR A CONVERSATION ABOUT SURGE PROTECTORS AND UPSES

Do you really need a surge protector? Is a UPS worth the extra
money? The experts weigh in:

Sharon Zardetto Aker: In 20 years of having multiple Macs
(there are six in use in the house right now), 10 years of which was
in the country where power came and went with strong breezes, I've
never had a surge problem affect any Mac, nor do I know of anyone
who has ever had that problem, so I'm a little uncomfortable with
this recommendation.

Dan Frakes: Consider yourself lucky! In my humble opinion, no
computer should ever be run without a surge protector. All it takes
is one incident to make a believer out of you!

Kirk McElhearn: I agree with Dan.

Adam Engst: Personally, I never use surge protectors, but I
wouldn’t run a Mac without a UPS. Power flickers too often for my
taste, and preventing the lost work is worth it.

Tonya Engst: I've found that an important side effect of running

a UPS, in addition to allowing a graceful shutdown at the beginning
of a power outage, is that I can work on days when the power flickers
frequently. In Seattle, probably once a month or more, and here in
Ithaca, certainly once every 6 weeks, we have a day when the power
goes out maybe 8 times, for about 20 seconds each time, over the
course of an afternoon. Without the UPS, I wouldn’t be able to work
effectively on those days.

Geoff Duncan: I would be more comfortable recommending a
voltage regulator or power conditioner over consumer-level surge
protectors, which are usually pretty useless. UPSes are even better.
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PERFORM DAILY TASKS

If you performed all the preliminary steps in Start on the Right Foot,
your daily maintenance ritual consists of at most two tasks, and at
best, none!

Back Up Changed Files

In the type of backup system I recommend, your backup software
begins by copying all your important files to some sort of external
media—preferably a hard drive. What counts as “important” is up

to you; it could be everything on your disk, just the contents of your
home folder or your Documents folder, or just the files you're actively
working on. But at a minimum, you should make a daily copy of any
files you could not re-create in a matter of minutes, such as your
saved email, photographs, and any documents you’ve spent hours
working on during the day.

I advocate performing additive incremental archives. This means
that after your first full backup of all the files you want (creating

the archive), each successive daily backup copies only those files
that are new, or have changed, since the last time (that’s the
incremental part); and it keeps the previous copies of the files, so
you can go back to an earlier version if you accidentally modify a file
you shouldn’t have (that’s the additive part; it also means that files
you delete on your hard disk remain in the archive).

NoTE In addition to automated daily backups, it never hurts to make extra
copies of files you're actively working on. If you take a moment to
drag such files to a network server or iDisk (or even make an extra
copy on the same drive) whenever you stop to take a break, you’ll add
yet another layer of safety to your valuable data.

If you configured your backup software to run on a schedule (see Set
Up a Backup System), this happens automatically every day. You may,
however, need to intervene in some cases, such as these:

« If you back up to optical discs, in which case you must insert new
media as requested

« Ifyou back up to a server that requires you to log in manually
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« If you back up from, or to, a computer that’s not always available
at the same time of day (such as an iBook, PowerBook, or
MacBook Pro)

Even if your backup software runs automatically, I recommend
checking its logs regularly to make sure that it ran and that it backed
up all the files you expected it to.

Download Software Updates

In Turn On Software Update, I suggested setting Software Update
to check for, and download, any new updates from Apple daily. If
you followed that advice, any important updates download in the
background, and Software Update informs you when they’re ready
to install. So your daily task is more of a don’t than a do: on the days
when that inevitable alert appears, asking if you want to install the
latest software updates, read about the updates but consider post-
poning installation for a few days—in other words, click Quit instead
of Install.

I say this for two reasons. First, software updates take some time,
and you may not have the time available at the instant Software
Update informs you new software is ready. Besides, updates occa-
sionally result in a cascading effect: now that you’ve updated X, Y no
longer works and must be updated; now that Y has been updated, you
must make changes to Z’s settings. For this reason, I find Saturday
mornings especially good for updating software (see Use Software
Update to Install Apple Software Updates, ahead).

Second, in the unlikely event that an update contains a major
error—as has happened a few times—waiting gives you a safety buffer.
If you check sites like MacInTouch (http://www.macintouch.com/) or
MacFixIt (http://www.macfixit.com/), you can get a sense of whether
an update has raised any serious issues. However, take isolated
reports of problems with a grain of salt. Updates can fail—or appear
to fail—for many reasons, including user error. The fact that one or
two people cry wolf should not dissuade you from applying an update.
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SIDEBAR A CONVERSATION ABOUT SOFTWARE UPDATES

Many people install software updates as soon as they appear, but
I recommend doing it once a week instead. Here’s what some other
experts have to say on the subject:

Kirk McElhearn: Daily isn’t always best for updates—it means
you're on the cutting edge and, since we’ve seen a handful of Apple
updates that were pulled or quickly revised in recent years, it might
be more risky than it’s worth.

Andy Affleck: I agree with Kirk; daily software updates are very
risky. I generally check MacFixIt and MacInTouch for a few days
after each update to be sure it’s a safe one. Doing software updates
weekly is safer.

Tonya Engst: I try to do my Apple Software Updates over the week-
end, because if they involve restarting it’s too much time out of the
day, plus it’s a distraction.

Chris Pepper: In my department, we have the “Never on Friday”
rule. The gist is that you should (a) assume that any work might

go horribly pear-shaped, and (b) never start a process you’re not
prepared to see through to its conclusion. Since we don’t like staying
late Friday night or working Saturday, we don’t start major upgrades
on Friday afternoon (unless they’re scheduled to run through the
weekend). For any substantial maintenance (weekly, monthly, and
especially annual), it’s probably worth running or checking a backup
first, and making sure you have twice as much time as you expect to
need, so you don’t start a process on Friday afternoon and suck away
your weekend if the upgrade doesn’t go smoothly.

Geoff Duncan: I check on Mondays but usually don’t install any-
thing at that point. Security updates have highest priority with me;

I might apply them as early as Wednesday. Anything else has to wait
until immediately after a backup and, following Chris’s postulate that
it’s going to take at least twice as long as I think it will, until I have
time.
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PERFORM WEEKLY TASKS

Your daily maintenance tasks are minor—and perhaps even happen
automatically. Once a week, however, you should set aside time for
some more in-depth housekeeping. Depending on your work habits
and system specifications, these weekly tasks might take 15 minutes
or they might take a couple of hours. If you find that you can’t finish
them all conveniently in one sitting, feel free to stagger them—one
each day of the week, for example—as long as any given task occurs
about once every week.

Clean Up Your Desktop

I want to ask you a personal question. How many icons—not counting
hard disks, network volumes, and removable media—are on your
Desktop right now? (My answer: 11, though I usually try to keep it
closer to 6. Ask me again tomorrow, after I've performed my weekly
housekeeping.) I know lots of people who regularly have dozens or
even hundreds of icons on their Desktops, who use it as a catchall for
downloaded files, work in progress, email enclosures, and everything
else that needs a temporary home. This is a bad idea! Here’s why:

« Mac OS X considers every icon on your Desktop a window, and
because every open window uses up a certain amount of RAM,
more Desktop icons means greater RAM usage.

« Exposé shortcuts notwithstanding, putting files and folders on
your Desktop makes them harder to find, because they’re so easily
hidden behind windows. (You can, of course, access the contents of
your Desktop folder in a regular Finder window, but some people
put items on the Desktop specifically to avoid working with Finder
windows.)

« Your Desktop displays files and folders in icon view, unlike the
more efficient list and column views available in other windows.
(Yes, I know, you can view the contents of your Desktop folder in a
window too, but work with me here...)

« Tossing lots of files into a single big storage area (wherever it may
be) creates more work later on when you try to locate specific files.
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« Ifyou use your Desktop to hold important items that you want to
keep “in your face” at all times, you’ll lose that effect when the files
become too numerous.

A cluttered Desktop slows you down, so take a few minutes once a
week to organize most (if not all) the items on your Desktop into
other folders.

I know of numerous organizational philosophies, but I have no wish
to impose a rigid system on you. Instead, simply consider these
suggestions for keeping files off your Desktop:

 If your chief concern is keeping track of a few important files,
use the Finder’s label feature (select a file and choose a color label
from the bottom of the Edit menu) to mark all high-priority files
in a given color. Then, use a smart folder to display all files on
your disk labeled with that color. Choose File > New Smart Folder,
choose Color Label from the first pop-up menu, and click the color
you used to label the files. Then click Save and give your smart
folder a name. The folder automatically updates itself to display
all the files labeled with the selected color, wherever they may
be stored on your disk.

Tip For details on using smart folders, read an article I wrote for
Macworld magazine titled “Cut through the Clutter”
(http://www.macworld.com/2006/01/secrets/febworkingmac/).

« Ifyou store downloaded files on your Desktop, instead make a new
folder named Downloads, put that on your Desktop (or somewhere
else convenient, such as in your Documents folder), and keep the
downloaded files inside it.

Tip To change the location to which Safari downloads files, choose
Safari > Preferences, click the General button, and choose a location
from the Save Downloaded Files To pop-up menu (choose Other to
select any folder on your disk).
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« Check your Desktop for files you no longer need, such as software
you’ve already installed, PDFs you downloaded and printed
(except this one, of course!), or outdated text clippings, and delete
them.

« Several Mac OS X applications function as excellent snippet
keepers, giving you a much better place to store things that might
otherwise go on your Desktop (URLs, saved Web pages, text
clippings, PDF and text files, and so on). Examples include:

« DEVONthink
http://devon-technologies.com/products/devonthink/
overview.php (Personal edition, $40; Professional edition, $75)

« NoteBook
http://www.circusponies.com/store/index.php?main_ page=
notebook&sub=organize ($50)

« StickyBrain
http://www.chronosnet.com/Products/sb_product.html ($40)

« SOHO Notes (see Figure 5)
http://www.chronosnet.com/Products/sohonotes.html ($70)

« Yojimbo
http://www.barebones.com/products/yojimbo/ ($40)

One way or another, try to get your total number of Desktop icons
below a dozen or so. You'll be surprised how much this simple step
improves your efficiency.

Tip If you like to keep files and folders on your Desktop because you find
it difficult to work with Finder windows, you may be able to improve
your experience considerably by customizing the default Finder win-
dow. You can learn all about Finder customization in Matt Neuburg’s
ebook Take Control of Customizing Tiger.
http://www.takecontrolbooks.com/tiger-customizing.html
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FIGURES [enoe SOHO Notes - Default Notes o

Back/Forward New Mote Note Info  Set Alarm Show Links Move to Trash SOHO Organizer Search
1 My Notes 7 motes, 1 selected
[ Unfiled Type Title & | Modified Size
» [ 7 alt concepts E] About Looking Up Passwords 1/6/06 1.6 KB i
i Default Notes =] Airline and Frequent Flyer Information 1/6/06 16.3 KB
=l iPod :l Area Codes (by number) 1/6/06 12.6 KB
= [E] Area Codes (by state) 1/6/06 12.5 KB
— s [E] Best Novels of the 20th Century 1/6/06 19.9 KB
f"fJ Passwords E] Toll-free Telephone Numbers 1/6/06 4.0 KB
| Persanal B World Capitals
M Receipts
[ 4 Take Control LR AT
|7 TidBITS Title: World Capitals Craated: 1/6/06 Modified: 1/6/06

= ‘World Capitals

Regions: Africa, Asia, Australasia, Eastern Europe, Europe, North & Central America, South
America

AFRICA

[ 13

ALGERIA poputation: 25,660,600
Algiers (population: 1,687,600)

ANGOLA (poputation: 16,303,600)
Luanda (population: 1,136,000)

BENIN (popuiation: 4,889,000)
+ | - Il Porto-Novo (population: 164,000)

SOHO Notes, whose interface is nearly identical to that of
StickyBrain, is a competent all-purpose snippet keeper.

Back Up Everything

You already back up important changed files every day to an archive
(see Back Up Changed Files), but a thorough backup plan also
includes a bootable duplicate of your entire hard disk, which enables
you to recover almost instantly from even a complete drive failure,
with all your files intact. You can certainly update this duplicate every
day if you wish, but because the process typically takes longer than
updating an archive, I suggest updating your duplicate at least once

a week.
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NOTE

The best place to store your duplicate is on an external FireWire
drive—external so that you can store it in a safe place, away from your
Mac, and FireWire because all Macs can boot from FireWire hard
drives (only the new Intel-based Macs can boot into Mac OS X from
USB hard drives). If you don’t have a spare hard drive, you could
store the duplicate on a stack of DVDs, though you would need to
restore them all to a functional hard disk to use the duplicate.

If you do choose to use an external hard drive, and if (as I recom-
mend) you store it offsite, you should think carefully about security,
because ordinarily, bootable backups cannot be encrypted (and vice
versa). Thus, anyone stumbling upon your drive could in theory read
anything on it.

A relatively new breed of external hard drive employs hardware
encryption using a physical digital key, which means your drive can
be both encrypted and bootable. You’ll pay extra for this capability,
but it may be worth it. Such drives include RocStor’s Rocbit drives
(http://www.rocsecure.com/) and RadTech’s Impact enclosures
(http://www.radtech.us/Products/Impact.aspx).

If you configured your backup software to run on a schedule (see Set
Up a Backup System), your duplicate should update itself automati-
cally every week. If you opted for manual duplicates (or if the drive
you use for duplicates isn’t always connected), update your duplicate
now.

NOTE

Most backup software, when duplicating your drive onto an external
volume, automatically performs an incremental backup—copying
only those files that are new or changed since your last duplicate, and
deleting files from the external volume that are no longer on your
internal disk.

Rotate Backups Offsite

In Set Up a Backup System, I recommended maintaining at least
two sets of backup media—for example, two hard drives, each with

a partition for a duplicate and another to hold your archives. With
two copies of your backups, you can keep one next to your computer,
ready for the next day’s backup, and another in a safe place offsite.
That way, if disaster strikes your home or office and takes out one
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of your backups, you have another to fall back on. If you swap your
backup sets weekly, you’ll rest secure knowing that even in the worst
possible case, you’ll lose no more than one week’s data.

Today, after your backup software updates your daily archive and
weekly duplicate, make the switch. Take the most recently used media
and move it to another building, such as a friend’s house or your
office (if your computer is at home). Then, bring back the media you
stored there last week, and you’ll be ready for a new round of back-
ups. You might even agree to a swap arrangement with a friend: every
week you trade hard drives, giving each of you an offsite location for
your data while keeping it in trusted hands.

WARNING!

Don’t store backups in your car. They’re likely to be damaged by heat,
cold, or humidity, and the risk of theft is much greater in a car than in
a building.

Use Software Update to Install Apple Software
Updates

Software Update checks for new versions of any Apple software you
have installed and (if you set it to do so) downloads them automati-
cally. As I mentioned in Download Software Updates, though, you
may wish to hold off on installing the downloaded updates until you
have more free time and have checked to make sure they contain no
serious flaws. When you’re ready to install the updates, follow these
steps:

1. Choose Software Update from the Apple menu. Software Update
checks for updates and displays a list of any it finds, including
those it has already downloaded but not yet installed (Figure 6).
(If no updates are available, Software Update displays a message
that says “Your software is up to date.” Click OK, and skip the rest
of these steps.)

2. Check the boxes in the Install column for the items you want to
install. (Items with a £} icon require a restart after installation.)
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3. Some items may not apply to you. For example, if you don’t have
an iPod, AirPort base station, or iSight camera, you can skip
software updates for these items. In such cases, you can prevent
Software Update from listing an item the next time it opens by
selecting the item and clicking Delete. (If you later wish to see
items you removed in this way, choose Software Update > Reset
Ignored Updates.)

FIGURE 6 Software Update

’F i New software is available for your computer.
) ﬁ) If you're not ready to install now, you can use the Software Update

preference to check for updates later.

Install Mame Wersion Size
iPod Updater 2006-01-10
= AirPort Update 2005-001 1.0 1.4 MB
| AirPort 4.2 12.3 M8

iPod Updater 2006-01-10 delivers:

F

o

iPod Software 1.1 for iPod |
iPod Software 1.1 for iPod nano |
iPod Software 1.2.1 for iPod with color display |
iPod Software 1.4.1 for iPod mini |
iPod Software 3.1.1 for iPod with Click Wheel |
.

For all other iPod models, iPod Updater 2006-01-10 contains the same
software versions as iPod Updater 2005-11-17.

important: After downloading the iPod Updater software, connect your iPod
to your computer and launch the iPod Updater application. If iPod Updater
determines that your iPod needs to be updated, click the Update button to
install the latest software on your iPod. w

Mote: Use of this software is subject to the original Software License Agreement{s}
that accompanied the software being updated. A list of Apple SLAs may be found
here: hitp:/ /www.apple.com/legal/slal.

( Quit ) € Install L item )

e

Select software updates to install in this window.
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4. Click Install, and then click through any license agreements that
appear.

Software Update installs your new software, prompting you to restart
if necessary. If no restart is necessary, click Quit.

Check for Third-Party Software Updates

Like Apple’s Software Update, third-party applications that have
built-in automatic update checkers give you the option of postponing
an update until a more convenient time. But some applications check
only when you explicitly tell them to. Therefore, take a few minutes
to launch your most frequently used applications and use their Check
for Updates features (see Update Third-Party Software for more
information). Download and install any free updates now, following
the developers’ instructions.

Tip Another way to check for the latest software is to subscribe to
VersionTracker Pro. This service includes software that runs on your
Mac and alerts you when updates to any of your installed software
become available, at which time you can download and install them
with a couple of clicks. VersionTracker Pro monitors up to three Macs
for an annual fee of $50, but see the coupon at the back of this ebook
before you buy.
http://www.versiontracker.com/subscribe/mactrial/

Reboot If Performance Seems Slow

Some people turn off their Macs whenever they aren’t in use, either
to save electricity or simply out of habit. Others leave them on all the
time, on the basis that sleep mode uses a trivially small amount of
energy and enables you to get back to work more quickly. (I fall into
the latter group, turning off my Macs only when I go on vacation, or
when for some other reason I expect to be away from them for more
than a day.)

If you leave your Mac on all the time, you may find that over a period
of days or weeks, its performance slowly degrades. One common
reason for this phenomenon is memory leaks (see RAM usage), but
other kinds of bugs can also lead to excessive RAM and CPU usage
that gradually bogs down your system. In addition, as you use your
Mac it may create virtual memory swap files on your hard disk if you
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run low on physical RAM; the more of these files actively in use, the
slower your computer runs.

When you begin to notice that your Mac doesn’t feel as peppy as
usual, try restarting (by choosing Restart from the Apple menu).

If you use lots of resource-intensive applications and have a slower
machine with comparatively little RAM, you may need to restart as
as frequently as every day; if you never notice any slowdowns, once
month may be adequate. You be the judge.

I talk more about keeping an eye on potential performance problems
later, in Monitor Your Mac’s Health.

Consider Clearing Certain Caches

As you use various applications, they often store frequently used
information in files called caches. For example, when you visit a Web
site in Safari, it stores the images from that site in a cache, so that the
next time you go to the site, it can display the images more quickly
(because it doesn’t have to download them again). Another example
is Microsoft Word, which can display the fonts in the Fonts menu in
their own typefaces. If Word had to read in all those fonts each time
you used it in order to build the Font menu, every launch could take
a minute or more, so Word builds a cache that contains all the data

it needs to draw the font names.

Caches are good things—usually. Sometimes they cause more
problems than they solve. One problem occurs when an application
has cached hundreds or thousands of files—so many that reading in
the caches takes longer than reading (or recomputing) the data they
contain, thus slowing down the application instead of speeding it up!
A more serious problem involves damaged cache files. Maybe an
application failed to write the file correctly in the first place, maybe
the information it put into the cache was bad, or maybe a disk error
corrupted the cache after the fact. Whatever the reason, a corrupted
cache file can cause an application to crash, run slowly, or exhibit any
number of incorrect behaviors.
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NoTE I discuss caches in some detail in a Macworld magazine article titled
“34 Software Speedups” (http://www.macworld.com/2006/02/
features/softwarespeed/).

Several utilities provide a one-click method for deleting one or all of
your caches. I recommend against blindly deleting all your caches; as
I said, they usually help rather than hinder. However, a few caches in
particular have notorious reputations, and clearing them periodically
tends to make the applications that use them run more smoothly. My
recommendations for weekly cache maintenance are as follows:

Clear your Safari cache by choosing Safari > Empty Cache
(Command-Option-E).

Tip Alternatively, you can disable Safari’s cache altogether. In the Finder,
navigate to the folder ~/Library/Caches/Safari. Select this
folder and choose File > Get Info. In the Ownership & Permissions
section of the Info window, choose Read Only from the pop-up menu,
and then close the Info window. This prevents Safari from being able
to write new files into the cache folder.

Safari stores favicons (those tiny icons that appear next to a site’s
URL in the address bar) separately from the main cache. To
remove them, quit Safari and drag the folder ~/Library/
Safari/Icons to the Trash.

Mac OS X maintains a system-level font cache that numerous
applications use. Bad font cache files have been implicated in
numerous problems. The easiest way to wipe out these caches is
by using Font Finagler (see Figure 7). Or, to delete most of your
font caches manually, drag the folder /Library/Caches/
com.Apple.ATS to the Trash. Enter your password when
prompted to do so, and click OK. Then restart your computer
and empty your Trash.
http://homepage.mac.com/mdouma46/fontfinagler/ ($10)
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FIGURE 7
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Date Modified
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| Inspect Font Cache Files )

[ Clean Font Cache Files )

Font Finagler’s Font Cache Cleaner window lists all your system’s
font caches and lets you delete them with a single click.

« Microsoft Office’s font cache seems more prone to problems than
the systemwide font cache. To clear it, quit all your Office appli-
cations and then drag the file ~/Library/Preferences/
Microsoft/Office Font Cache (11) to the Trash.
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PERFORM MONTHLY TASKS

Once a month—perhaps on a different day from the one on which you
perform your weekly tasks—set aside about 15 minutes to perform
four additional maintenance tasks: emptying your trash, running

Disk Utility, cleaning your screen, and cleaning your mouse or
trackball.

Empty Your Trash

I have no doubt that some readers are now concluding I’'m out of my
mind. Empty my Trash once a month?! What could he be thinking?
The thing is, of those people, some of them are thinking that once a
month is far too seldom, and others are thinking it’s far too often!

Your Trash, as you probably know, is simply another folder. As a
result, moving files or folders to the Trash does not delete them, just
as tossing a crumpled paper in a physical trash can doesn’t automat-
ically turn it into landfill. On your Mac, as in your home, the contents
of the Trash continue to take up space until you empty the Trash (in
the Finder, choose File > Empty Trash). When you empty the Trash,
you free up that now-unused space for other files.

How often should you do this? It depends on how you think about the
Trash.

Let me put my cards on the table: I am a compulsive Trash emptier.

I picked up this habit many years ago when I was struggling to make
do with a 20 MB hard disk and every kilobyte counted. If I left items
in the Trash without emptying it for more than a few hours, I'd run
out of space—simple as that. Today, even though I have a large hard
drive with plenty of free space, I still haven’t kicked that habit. On the
other hand, because I know I'll be emptying the Trash shortly after
putting a file there, I tend to think of moving files to the Trash as a
final deletion from which recovery is impossible, so I don’t take that
step unless I'm entirely sure I can do without that file.

On the other end of the spectrum are what I’ll call pack rats. They
cringe at the idea of getting rid of anything for good. For them, the
Trash is just another folder, and unlike a physical trash can, it never
gets full. You can keep putting stuff in there for as long as you want.
So they freely move files and folders to the Trash that don’t seem
especially important at the moment—just to get them out of the
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way—because they realize they can open up that folder at any
time and get the files back.

In between, of course, are most of the rest of us. Each person’s Trash
philosophy is a bit different from the next person’s. If you're that
hypothetical person right in the middle of the Trash emptying
spectrum—neither a pack rat nor a compulsive emptier—let’s just
say that today is a good day to empty the Trash.

For everyone else, here are some reasons why you might want to
move toward the center, toward what I'm proposing as the happy
medium of monthly Trash emptying.

For those on the compulsive side, consider this:

« Everyone makes mistakes. You can probably recall at least one
occasion when you had to fish a file out of the Trash. Remember
that once you’ve emptied the Trash, the only way to recover
deleted files is to try expensive (and often unsuccessful) undelete
utilities or to send your drive to a much more expensive data
recovery service. Giving yourself a bit of a safety net might save
you grief later.

« Modern hard drives are large enough that you probably won’t run
out of space if you wait a few weeks before emptying the Trash.

« You'll be able to focus on your work and be more productive if you
don’t keep glancing down to see if the Trash can is full.

For those who lean more toward being pack rats, think about this:

« How many times have you had to recover a file from the Trash that
was more than a month old. Ever? If that’s a common occurrence,
you should seriously consider revising your filing habits.

« Hard drives are large, but not infinite. You will eventually run out
of space (see Disk usage). In the meantime, all those extra files can
contribute to increased file fragmentation, potentially decreasing
your Mac’s performance (see Defragment Your Hard Disk).

« All those extra files, merely by sitting in the Trash, could result in
productivity losses due to misleading Spotlight searches and
longer waits for backups and diagnostic utilities to run.

Page 47



And for everyone, regardless of how frequently you decide to empty
the Trash, here’s one huge piece of advice: look before you leap. Get
into the habit of opening the Trash folder (by clicking the Trash icon
in your Dock) and scanning its contents before you empty it. It may
take you a few minutes, but you're far less likely to delete a file by
mistake that way.

SIDEBAR A CONVERSATION ABOUT EMPTYING THE TRASH
How often should you empty your Trash? Let’s ask the experts:

Sharon Zardetto Aker: I've always recommended, especially to
the pack rats, that they create a folder called “To the Trash” and put
stuff in there. At intervals, sort by modified date and anything older
than [choose the age] goes to the Trash and gets emptied. You lose
the convenience of having Command-Delete send to the Trash this
way, but you don’t have to review the Trash contents.

Kirk McElhearn: One problem with that approach is like-named
files that overwrite existing files in the “To the Trash” folder. This
doesn’t happen with the Trash, which renames files if necessary.

Peter N Lewis: I'm not a pack rat, but I've trained myself to never
empty the Trash unless absolutely needed. I find it hard to believe
that issues of fragmentation and what-have-you are going to slow the
computer down noticeably if you have a large hard drive that never
comes near being full. Backups can be configured to avoid backing up
the Trash folder if necessary.

Adam Engst: I'm with Peter on this; I empty the Trash only when I
need the disk space or when there’s some other reason to eliminate a
particular file entirely (and when I'm too lazy to get rid of it individu-
ally via Terminal).

Joe Kissell: One big advantage to frequent Trash emptying is that
Spotlight searches don’t produce long lists of deleted (and therefore,
in my way of working at least, irrelevant) files.

Tonya Engst: So many of the files in my Trash begin with “TCo” (for
Take Control of) that I like to clear it out periodically so that I can
easily find stuff if I put it in there accidentally. Otherwise, I'm
scrolling through hundreds of versions of old ebook manuscripts.
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Use Disk Utility’s Repair Disk Feature

Earlier, I suggested using Disk Utility’s Repair Disk feature to pre-
emptively check for and eliminate common disk gremlins (see Run
Disk Utility). Because disk errors do creep in during ordinary com-
puter use (seemingly of their own accord), I suggest running Disk
Utility and using its Repair Disk command once a month.

SIDEBAR WHY Do Disk ERRORS OCCUR?

In addition to Disk Utility, numerous third-party utilities check for,
and attempt to repair, a wide range of disk errors. I've run these
utilities hundreds of times over the years, and a shockingly large
proportion of the time they’'ve found and fixed errors—even though
I wasn’t aware of any problem. What causes these problems in the
first place?

Although I can’t give you a complete answer to this question, I can
offer a few reasons some disk errors occur:

« Buggy software: Virtually all software contains some bugs, and
bugs can cause bad data to be written to your disk or can corrupt
existing data.

« Hardware failures: If your hard drive, logic board, or various
other components have manufacturing defects—or develop mal-
functions later on—these can result in disk errors.

« User error: If you unplug an external hard drive without un-
mounting the volume(s) first (File > Eject), you may interrupt the
flow of data to the drive, or interrupt a housekeeping procedure.
Many other user errors can also result in disk problems.

« Power failure: If the power goes out (or your battery dies) at an
inopportune moment, a file may not be written properly.

In other words, stuff happens. You can guard against some problems
simply by being careful, but stuff will still happen.

Clean Your Screen

Your computer’s display attracts dust, and over time that can impair
the screen’s readability. (It’s also, let’s face it, just yucky.) Once a
month, or whenever you can see a thin layer of dust on a black screen,
give it a quick cleaning.
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To clean a screen, use a soft, lint-free cloth—not a paper towel—
moistened slightly with water to prevent static buildup. (You can also
use cleaning solutions designed expressly for computer displays, but
avoid anything containing alcohol or ammonia.) Wipe the screen
gently; LCD displays, especially, can be damaged by excessive force.

Tip I've had good results with iKlear screen cleaning products from Klear

Screen (http://www.klearscreen.com/).

Clean Your Mouse or Trackball

I spent five years working for Kensington, a company that made its
reputation in the Mac world by selling fantastic mice and trackballs.
During the time I worked there, we saw the computing world tran-
sition from optomechanical devices (in which a ball turns slotted
rollers connected to wheels whose speed and direction were measured
with photosensors) to purely optical devices (in which a tiny camera
tracks changes in the texture of your desk’s surface, or the trackball’s
surface).

The biggest and most exciting advantage of optical designs was sup-
posed to be that they never had to be cleaned. Gone were the old days
of disassembling a mouse, losing the ball as it rolls across your office
floor, and fumbling with cotton swabs to clean dirt and hair off of tiny
rollers—a procedure you might have to repeat every few weeks or so.
Optical mice have no moving parts—no rollers, no ball—so cleaning
should never be necessary.

Experience has shown that although optical devices require less
cleaning, they still require some. Specifically, optical mice tend to
accumulate dust inside the opening at the bottom (often shaped like
a keyhole) through which the sensor watches your desktop. If it
becomes clogged, your pointer may move erratically, or not at all.

Optical trackballs have a similar opening above the lens (remove the
trackball from the casing to see it) with a similar tendency to attract
dust. In addition, the tiny bearings or rollers on which the ball rests
can collect dust and hair, preventing the ball from moving smoothly.

And, of course, plenty of Mac users still have older pointing devices
that use the ball-and-roller mechanisms and therefore require what
we now think of as old-fashioned cleaning.
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Your input device most likely came with cleaning instructions, so I'll
simply say: follow them now. If you don’t have the instructions (and
can’t find them on the manufacturer’s Web site), they generally boil
down to removing visible dust and gunk from wheels, rollers, bear-
ings, and other moving parts (and away from the openings used by
optical sensors). A slightly moistened cotton swab will do the job
nicely.

TiP CLEANING MIGHTY MOUSE’S SCROLL BALL

The miniature trackball that enables you to scroll with an Apple
Mighty Mouse can accumulate dirt, leading to poor scrolling perfor-
mance. You can’t remove the ball, but you can generally dislodge any
dirt by inverting the mouse, pressing the ball inward as far as it will
go (it springs inward slightly), and rolling it vigorously in every
direction. If scrolling is still not smooth after you do this, repeat the
procedure using a slightly moistened cloth or paper towel.

For most people, once a month is a reasonable cleaning interval. If
you have pets, you may need to clean your mouse or trackball more
frequently; if you work in an Intel clean room, maybe never!

Exercise Your Notebook’s Battery

Early portable computers used NiCad batteries, which were subject
to the dreaded “memory” effect. To get maximum run time from
them, you had to discharge them completely before recharging them;
if you failed to do this, even a fully charged battery might suddenly
run out of power after a short time.

The lithium-ion batteries used in modern Mac notebooks (and iPods)
don’t suffer from memory, but according to Apple they still need to be
“exercised” (that is, discharged and recharged periodically) for max-
imum performance. If you leave your notebook plugged in all the
time, the battery never discharges beyond a few percentage points,

so it gets insufficient exercise. For such users, Apple recommends
that once a month you unplug your computer, run it on the battery
until it discharges completely, and then recharge it.

For more information about Apple’s notebook batteries, see
http://www.apple.com/batteries/.
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Check for Take Control Updates

All right, this isn’t exactly Mac maintenance, but it’s a good idea
anyway. Every month, open each of the Take Control ebooks you
own and click the Check for Updates button on the cover. If a newer
version is available, you’ll be able to download it, and if not, there
may be updated information or news about an upcoming release.
Make the most of your investment by keeping current with Take
Control!
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PERFORM YEARLY TASKS

If you've ever looked around your home and thought, “It’s time for a
good spring cleaning,” you know the value of decluttering. On your
computer, as in your home, make an annual ritual of removing dirt,
tossing out junk, and putting your belongings in order. Besides giving
you a cleaner, more inviting environment, these yearly tasks can
extend your computer’s life span and help keep your data safe.

De-Dust Your Mac

Nearly all Mac models employ one or more internal cooling fans.
Without them, your computer would overheat, leading to crashes,
erratic behavior, and possibly even permanent damage to sensitive
components.

But as the fans pull air into the computer, they also pull in dust. Dust
can accumulate on the air intake vents, on the fan itself, or on any
surface along the flow of air within the computer. When a layer of
dust sits atop a hot component, it acts as an insulator, preventing
some of the heat from escaping into the air. And if dust blocks the air
flow, the heat that does escape has nowhere to go. Either way, your
fan must work harder, which not only makes it noisier but also makes
it suck in even more dust.

In short, dust is no friend of computers. By the simple act of getting
rid of the dust, you can make your Mac cooler and quieter—and
prevent all sorts of unpleasant problems.

You can remove dust by brushing or wiping, by vacuuming, or by
blowing it off with compressed air. The compressed-air approach is
the least desirable, because it puts the dust right back into the air. I
prefer an ordinary vacuum cleaner with a hose attachment, but before
using such a vacuum on the inside of your computer, take note of the
warning just ahead. If you choose the brushing or wiping approach,
be sure to use a soft, dry cloth or a soft, dry brush—and a gentle
touch.
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WARNING! Conventional AC-powered vacuum cleaners, particularly those with
plastic nozzles, can in theory build up enough static charge to damage
your computer’s circuitry if used on the inside of a case. To vacuum
inside a computer, use either a battery-powered vacuum or an anti-
static vacuum designed expressly for cleaning electronic gear. In any
case, be careful not to touch the nozzle to any components inside
your computer.

To de-dust your Mac, follow these steps:

1. Shut down and unplug your computer; also unplug any peripherals
or other cables.

2. Be sure you have room to work in. If your computer is located
under a desk, for instance, move it out into the open.

3. Using your dust-removal tool of choice, remove dust from in or
around any holes or slots on the outside of the case. Be aware that
some of these openings may be on the bottom or the back of the
case, depending on the design.

These remaining steps are for desktop computers only:

4. Following the instructions that came with your computer for
installing RAM or other internal options, carefully open the case.
The method for doing this varies widely from model to model. For
example:

« Most Power Mac models have a side panel that you can remove
without tools by opening a latch.

« Remove the back cover of iMac G5 models by placing the com-
puter face down on a soft cloth and loosening three screws in
the grill on the bottom.

« For iMac G4 models, turn the computer on its side (again, using
a soft cloth to protect the display), and loosen the screws on the
bottom plate.
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NoTE Some iBook and PowerBook models have removable keyboards or
other ways to access the innards without performing major surgery.
But even if you can see part of the computer’s insides, you're unlikely
to be able to reach spots where dust might accumulate. My advice
is to leave the inside of a portable Mac alone; if you have reason to
believe you have an internal dust problem, find an authorized service
technician to open up the computer and clean it for you.

5. Once again, remove any visible dust using your tool of choice. If
your PowerMac has add-in PCI or video cards, be sure to remove
the dust from them as well. (In some cases, you may need to re-
move the card from the computer, de-dust, and reinsert it. If you
do remove a PCI card, be sure to ground yourself—ideally, by
wearing an antistatic strap—while handling it.)

WARNING! Be extremely careful when removing dust from the inside of your
computer! If using a vacuum cleaner, avoid touching the hose tip or
brush to any surface. If using a brush or cloth, apply the gentlest
pressure possible.

6. Close the computer’s case, reattach peripherals and other cables,
and turn it back on.

WARNING! Avoid the temptation to perform any further disassembly on your
computer beyond merely opening the case. As a general rule, if you
have trouble reaching some spot inside your computer, so does dust.

Clean Your Keyboard

Before you put away that vacuum cleaner or canned air, give your
keyboard a once-over too, following these steps:

1. Unplug the keyboard from your computer. (For portables, turn off
the computer.)

2. Most keyboards cannot be disassembled easily, so don’t even try.
Instead, simply invert and shake to dislodge any large particles.
For larger or more stubborn particles, you may need to use
tweezers or a slightly moistened cotton swab.
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3. Run the vacuum cleaner or compressed air between all rows of
keys.

4. Using a soft and very slightly damp cloth, carefully wipe the
keycaps clean. (Some heavy-duty stains may require the use of a
mild all-purpose cleaner, but be sparing, because fluid that drips
into the keyboard circuitry can damage it.)

5. If you're the patient type and your keyboard is especially cruddy,
use a very slightly moistened cotton swap to clean the sides of the
keys.

6. Plug your keyboard back in.

Clean Your iSight

If your computer has an iSight camera (either built in or external),
this is also a good time to make sure it can see you clearly. Follow
these steps:

1. Unplug your iSight (if appropriate).

2. Use a soft, very slightly damp cloth (or lens-cleaning paper,
available from any camera store) to wipe the front surface,
applying only gentle pressure.

WARNING! Do not use alcohol, ammonia, or any other chemicals; use only water.

3. Buff with a soft, dry cloth.
Make Archival Backups to DVD

By now, regular backups are a normal part of your routine: your
backup software automatically updates your archives every day and
your duplicates once a week, and you diligently rotate backup media
offsite—right? (If not, see Back Up Changed Files, a daily task, and
the weekly tasks Back Up Everything and Rotate Backups Offsite.)
Even so, I recommend adding one final element to your backup
regimen: archival DVDs.

If you’ve followed my advice, you already have archives of all your
important files—going back several months or more—on each of two
or more hard drives. You also have one or more complete, bootable
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copies of your main hard disk as it existed at some recent time. This
is all good, but some problems remain:

« Hard drives don’t last forever. Sooner or later—in a year, or five or
ten years—you’ll no longer be able to access the data on your
drives.

« Because archives constantly get bigger, the archive can eventually
outgrow the drive you store it on.

« Asyour main hard disk fills up, you may want to delete files
periodically to save space (see Remove Unneeded Files, next) and
yet be able to retrieve those old files if you later need them.

I'm aware of several schools of thought regarding archival backups,
so bear in mind that this is just one person’s take on the process.
In a nutshell, I recommend this: once a year, make a copy of all
your backups (both archive and duplicate) onto a stack of DVDs,
store them in a safe place, and then recycle the hard disk you use
for archives by erasing it and starting over with a new, full backup.
By doing this, you hedge your bets against hard drive failure, free
up valuable space for archives, and give yourself a safety net in
case you want to prune files on your primary hard disk.

NoTE I hasten to point out that DVDs don’t last forever either, but if you
store them carefully in a dark, cool, dry place, they should be read-
able for ten years. By the time you approach that point, if you still
want to keep the data, you should migrate the contents of your discs
onto new media.

To archive your data, obtain a big stack of recordable DVDs and
follow these steps:

1. Make sure you have a backup application that can create
duplicates and span data across multiple discs. Examples include:

« Impression
http://babelcompany.com/impression/ ($49)

« Intego Personal Backup X4
http://www.intego.com/personalbackup/ ($70)
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« Retrospect Desktop
http://www.dantz.com/en/products/mac_personal /index.dtml
(downloadable copy, $119; boxed copy, $129)

 Retrospect Express
http://www.dantz.com/en/products/express.dtml
(free with purchase of selected third-party hard drives, or
available as part of Allume’s $100 ChecklIt suite:
http://www.allume.com/mac/checkit/)

« Toast 7 Titanium
http://www.roxio.com/en/products/toast/ ($100)

. Attach the drive you use for archives (if it’s not already attached).

. Following the instructions included with your backup application,

select your archive drive as the source and your DVD burner as the
destination.

. Begin the backup process, feeding in blank discs as needed.

When the backup completes, repeat Steps 3 and 4 with your
primary hard disk as the source (or, if you prefer, use a recent
duplicate as the source).

. Store your newly burned DVDs in a dark, cool, dry place.

Tip Better yet—if you can afford the time and the media—make two
complete copies of both archives and duplicates, and store them in
different places.

7.

Configure your backup software to replace the existing archive
with a fresh, full backup on its next run. (In some cases, you may
need to erase the drive manually first.) Again, consult the docu-
mentation that came with your backup software for details.

Now that you have a safe copy of all your data, you can consider
deleting files to make extra space on your main hard drive, as I
describe in the following section.
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Remove Unneeded Files

Just as your home probably needs a good spring cleaning once a year,
your computer can use a digital tidying-up now and then. So take this
opportunity to get rid of applications you don’t use, outdated files
you’ll never look at again, and any other crud that has gathered in the
dark corners of your hard disk.

The process is the same one I described near the beginning of this
ebook. Flip back to Clean Out Accumulated Cruft for complete
instructions, and repeat that procedure now.

Change Your Passwords

Passwords are a fact of life in the wired 21st century. You probably
have dozens or even hundreds of passwords, such as these:

« Your Mac OS X administrator password
« Passwords for .Mac and any other email accounts you may have
« Passwords for Web sites and other online services

« A password for your AirPort base station, and perhaps another one
for your wireless network

« Passwords that protect encrypted files, folders, or volumes (such
as your backups)

It’s easy to become lazy—choosing short, easy-to-type (and easy-to-
remember) passwords and reusing the same password in multiple
places. The Mac OS X keychain enables you to store most of your
passwords in one place and access them easily, but it can also
contribute to password laziness by keeping you from noticing how
often your passwords are required.

If you’re the only person who uses your computer, and if you don’t
access sensitive information online (such as bank accounts or propri-
etary corporate data), you can probably get away with relatively few
passwords that remain the same indefinitely. Otherwise, I strongly
recommend changing your passwords—at least, those that protect the
most sensitive information—once a year (or more often). That way, if
someone were to guess one of your passwords, it would be useful for
only a limited period of time.
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Look for passwords to change

Each Web site, application, or device has its own procedure for
changing passwords, and I can’t begin to cover them all here. I will,
however, mention a few common places to look:

« To change your Mac OS X user account password, go to the
Accounts pane of System Preferences. Select your user name in
the list on the left and click the Change Password button in the
Password view.

« To change your .Mac password, go to http://www.mac.com/ and
click the Log In link on the right side of the blue .Mac tab, which
runs across the top of the window just under the row of tabs. Enter
your member name and password. Then click your member name
on the .Mac tab (logging in again if asked to do so) to display the
Account Settings page, click Password Settings, and follow the
instructions.

« To change the password used by your AirPort base station or your
wireless network, open AirPort Admin Utility (in /Applications/
Utilities). Select your base station and click Configure. Then,
in the AirPort view, to change the password of the base station
itself, click Change Password. To change the password of your
wireless network, click Change Wireless Security.

In addition, I recommend opening Keychain Access (which is also in
/Applications/Utilities) and looking through the passwords
stored there. That will give you an important reminder of many of the
Web sites and applications for which you've already established
passwords.

Choose a good password

You’ve undoubtedly heard this sermon before, so I won’t beat you
over the head with it, but let me briefly reiterate the qualities of a
good password:

« Longer is better: A 16-character password is much more secure
than a 6-character password, and even longer is better still.

« No common words: Don’t use a word (or words) from the dic-
tionary as your password; a hacker can break it easily. Also avoid
words and numbers people might guess: your favorite color, date
of birth, pet’s name, and so on.
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« Mix letters, case, and numerals: Every password should
include at least one uppercase letter, at least one lowercase letter,
and at least one numeral.

Luckily, Tiger includes a tool to help you create passwords that
meet these requirements: Password Assistant. Whenever you create
a new password (for instance, in the Keychain Access utility or in
the Accounts pane of System Preferences), a | ? button appears next
to the New Password field. Click this button to display Password
Assistant (Figure 8).

FIGURE 8

e Password Assistant Password Assistant

Type:  Memorable =] | enables you to generate
| passwords of any
desired length and type.

Suggestion: pesetaslZ4-Maori .

Length; « L= 16

auatiy: |

Tips:

To use Password Assistant, follow these steps:

1. Choose a type from the Type pop-up menu. Most of the choices
(Memorable, Letters & Numbers, Numbers Only, Random) are
relatively self-explanatory. The choice FIPS-181 Compliant creates
passwords that comply with the U.S. Department of Commerce
standard. The options Memorable and Random may also include
punctuation.

2. Move the slider to the desired password length.

3. If you don’t like the automatically generated choice shown in the
Suggestion field, click the arrow at the right of the field to see other
options, or choose More Suggestions to generate even more. For
each password, the Quality bar fills up farther to the right as the
password becomes harder to guess (either by a person or a
computer).
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THINGS YOU MIGHT NEVER NEED 10 DO

Careful readers may have noticed that I omitted two common tasks
from my recommendations of periodic maintenance procedures:
repairing permissions and defragmenting your hard disk. Read this
section to discover why you might never need to do these things—or
whether you're one of the few people who should.

Repair Permissions

If you visit Mac discussion forums, blogs, and news sites, you've
probably seen repeated recommendations to use Disk Utility’s Repair
Permissions feature. Some people recommend repairing permissions
on a daily basis, or before and after every software installation, or as a
first troubleshooting step when any sort of problem arises. Anecdotes
abound about the magical curative (or prophylactic) properties of this
feature, so it has achieved a mythical status—in much the same way
rebuilding the desktop file was a standard cure-all under Mac OS 9.

At the risk of being labeled a heretic, I'd like to suggest that in most
cases repairing permissions is nothing more than a placebo. True, the
procedure can solve certain problems and rarely does any harm, but
as a routine maintenance task, I consider it a waste of time. To
explain why, I should provide a bit of background.

In Mac OS X, each file contains information specifying which users
(or parts of the system) can read it, modify it, or execute it. This
information is collectively known as permissions. If a file has
incorrect permissions, it can cause applications to misbehave in
various ways, such as crashing or failing to launch.

Ordinarily, installers set the correct permissions for the files they
install, and the permissions stay that way permanently. However, a
poorly written installer can mess up permissions—even for files it did
not install—and if you use Unix commands such as chown and chmod,
you can accidentally set files’ permissions incorrectly. These sorts of
problems occur infrequently, but they do occur.

The Repair Permissions feature looks for software installed using
Apple’s installer, which leaves behind files called receipts that list the
locations and initial permissions of all the files in a given package.
Repair Permissions compares the current permissions to those listed
in the receipts and, if it finds any differences, changes the files back.
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The command ignores software installed in other ways (using a
different installer or drag-and-drop installation, for instance) and
knows nothing about legitimate permission changes you may have
made deliberately.

Although I said earlier that some kinds of disk problems can occur
without any provocation (see the sidebar Why Do Disk Errors Occur?,
earlier), permissions don’t go out of whack all by themselves; you (or
software you install) must do something to change them. And not all
changes are bad; in many cases, a file’s permissions can be different
from what they were originally without causing any problems. So
repairing permissions makes little sense as a regular activity.

NoTE I should mention that Apple suggests repairing disk permissions after
installing new software. I suspect that their reason for doing so is to
head off tech support calls about problems resulting from the use of
a few poorly written third-party installers.

I do, however, recommend repairing permissions as a troubleshoot-
ing step if (especially right after installing new software) you find that
an application no longer launches, or produces inexplicable error
messages. To repair permissions, follow these steps:

1. Open Disk Utility (in /Applications/Utilities).
2. Select a volume in the list on the left.
3. In the First Aid view, click Repair Disk Permissions.

Disk Utility resets the permissions of files installed using Apple’s
installer.

Tip For much more detail about permissions, I recommend reading Brian
Tanaka’s Take Control of Permissions in Mac OS X.
http://www.takecontrolbooks.com/permissions-macosx.html

Defragment Your Hard Disk

As you use your computer, your files gradually become fragmented
into smaller segments scattered across your disk. Some people
consider this a serious problem and go to great lengths (and expense)
to correct it. Before worrying about fragmentation, you should
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understand how and why it happens—and what the real-world
consequences are.

Pretend, for the sake of illustration, that your hard disk consists of
exactly ten blocks, and that initially, your disk contains five small files
(A, B, C, D, and E), each of which takes up exactly one block. Your
disk looks tidy and clean, something like this: ABCDE

If you delete files B and D and add a couple of new files, F and G, your
disk looks like this:A_ C_EFG_ _ _ . If you then add a file H that’s
twice as big as the others, the drive puts it at the end, like so:
A_C_EFGHH_ . Now let’s say file G grows to two blocks in size.
There being too little space between F and H, G must split into two
segments: A__ C_E FGHHG. Finally, if you add file I and delete file

F, your disk looks like this: AIC_E_GHHG.

Are you with me so far? Now imagine this happening with hundreds
of thousands of files of many different sizes. Some tiny files might
occupy just one block, while some huge ones may occupy millions of
blocks. The more you read and write files, the more jumbled the data
becomes: individual files split into numerous noncontiguous chunks,
and lots of small, empty spots where other files once lived. That’s
fragmentation: the normal state of your hard disk!

Ordinarily, you never notice fragmentation, because Mac OS X

keeps track of which parts of which files are where, and automatically
reassembles or disassembles them as needed. With modern hard
drives, this process goes so fast that it’s normally imperceptible.
Furthermore, starting with Panther, Mac OS X included automatic
background defragmentation of smaller (<20 MB) files, so that
although files may not be contiguous with each other, at least most

of them are in one piece.

The problem occurs when you have programs that must read or write
massive amounts of information in real time, such as audio or video
recording and editing applications. When these large files become
fragmented, the drive’s read-write head must physically zip back and
forth over the disk to get all the segments, and sometimes the rate at
which it does the zipping is too slow to keep up with the amount of
data coming in (or going out). The results can include gaps in the
data, stuttering, or slow application performance.
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For ordinary users, defragmentation is a waste of time unless the
fragmentation is extraordinarily severe (as evidenced by long delays
in opening and saving files). But if you use high-end audio or video
applications regularly, occasional (say, monthly) defragmentation

is worthwhile. Several utilities pick up where Mac OS X leaves off,
performing thorough defragmentation and making sure all the empty
space on the disk is contiguous, in order to squeeze every last bit of
performance out of your drive. The process is quite slow, however—
and if you’re defragmenting large disks, your computer could be
effectively out of commission for many hours. I recommend letting
the process run overnight (or better yet, over a weekend). Defragmen-
tation is also somewhat risky, since it involves deleting and rewriting
almost every file on your drive. A good backup is always essential
before undertaking defragmentation.

NoTE Related to defragmentation is optimization, which means moving

the most frequently used files to the portions of the disk that can be
accessed most quickly. Most utilities that defragment also optimize.

Utilities that perform defragmentation include:

- Disk Defrag (part of SpeedTools Utilities)
http://www.speedtools.com/STUS.shtml ($100)

« Drive Genius (see Figure 9)
http://www.prosofteng.com/products/drive_genius_info.php

($100)

« iDefrag
http://www.coriolis-systems.com/iDefrag.php ($30)

« TechTool Pro
http://www.micromat.com/tt_pro_4/tt_pro_4.html ($98)
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Defragmenting hard disks is one of Drive Genius’s many capabilities.

Tip Another way to defragment your disk is to make a complete, bootable
copy (a clone) onto another hard disk, erase the original disk, and
then reverse the process, cloning the backup disk onto the original.
When the computer writes data to an empty drive, it automatically
makes all the files contiguous.

Note that you cannot make a bootable clone simply by dragging files
onto another drive. You must use a utility designed to do that job,
such as SuperDuper! (http://www.shirt-pocket.com/SuperDuper/;
$28), Carbon Copy Cloner (http://www.bombich.com/software/
ccc.html; free, donations accepted), or most full-featured backup
programs.
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WHEN A NEW VERSION OF MAC OS X IS RELEASED

Every 18 months or so, Apple rolls out a new, major update to Mac
OS X. The current version, Mac OS X 10.4 Tiger, will be replaced by
Leopard (10.5) in the not-too-distant future. As of early 2006, I don’t
yet know exactly when this will happen or what Leopard’s features
will be. I do know that in the weeks preceding the introduction of Mac
OS X 10.5, I'll be working hard on Take Control of Upgrading to
Leopard, and that most Mac users will want to upgrade. In anticipa-
tion of these facts—and of similar upgrades in the future—I'd like to
share some advice you should follow whenever Apple releases a major
new version of Mac OS X.

NoTeE Even more important than the major upgrades is keeping current
with minor updates to Mac OS X, because these are likely to fix
serious bugs and security holes. For more information, read Install
the Latest Version of Mac OS X and Use Software Update to Install
Apple Software Updates.

Buy It!

For the past several years, Apple has consistently charged $129 for
major Mac OS X upgrades. As much as we might all wish they were
less expensive, I recommend adding that amount to your budget right
now; ultimately, you’ll get much more than your money’s worth.
Major upgrades invariably contain features that enable you to get
more done in less time and with less effort. If time is money, up-
grades pay for themselves. So plan to make that investment, and

it won’t seem like such a big deal when the time comes.

Buy Take Control of Upgrading to

Barring unforeseen problems, I expect Take Control of Upgrading
to Leopard will go on sale at exactly the same moment Leopard does,
as was the case with Panther and Tiger. And in all likelihood, I'll
continue creating new Take Control of Upgrading ebooks for each
new version of Mac OS X. I write these ebooks based on weeks of
extensive testing and dozens of installations of the new operating
system on numerous test machines.
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But you're already spending $129 on the OS itself, so why should you
pay even more for an ebook about how to install it? Isn’t it just a
matter of popping in a DVD and clicking a button?

If only it were so. Every upgrade of Mac OS X brings with it not just
new features and bug fixes but brand-new hardware and software
incompatibilities, installer oddities, and confusing custom installation
options. The Take Control of Upgrading ebooks provide expert
guidance through every step of the process, helping you understand
every option, keep your data safe, and make sure everything works
properly afterward. I'm sure you’ll find them to be money well spent.

Make a Fresh Bootable Backup

Before performing any major system upgrade, be sure to make a
new, fresh duplicate of your startup drive (even if you regularly make
duplicates once a week). In fact, resources permitting, make two.
System upgrades can cause many things to go wrong, and you’ll
appreciate the security of knowing you can restore your system

to its previous state if a problem occurs.

Upgrade

You may be surprised how often someone purchases a Mac OS X
upgrade, reads about the installation process, and then leaves the
DVD in a drawer for months. Some people habitually wait until the
first or second minor update after a major Mac OS X release before
taking the plunge, whether to give Apple time to work out all the bugs,
to give developers time to update their applications for compatibility,
or to see how other people like it before committing themselves. And
others feel nervous about upgrading until it’s nearly time for the next
major version to be released! Don’t let this happen to you.

I'm an early adopter, and although I've experienced my share of
minor hurdles, I've never regretted a decision to upgrade immedi-
ately. You may, however, wish to delay an upgrade if you're in the
middle of a project and can’t afford any downtime, if you rely heavily
on an application that has not yet been updated to work under the
new system, or if you expect to buy a new Mac in the near future
(which will, of course, include the latest version of Mac OS X).
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MONITOR YOUR MAC’S HEALTH

No matter how diligently you perform the maintenance tasks I recom-
mend in this ebook, you won’t truly know how well (or how poorly)
your Mac is running unless you make the effort to find out. The fact
that no smoke is billowing from your SuperDrive is a good sign, of
course, but it’s hardly definitive proof that all is well. In this section,

I show you how to find out what’s going on under the hood.

Use Monitoring Utilities

Numerous utilities (most of them free) can provide up-to-the-minute
vital statistics about your Mac. In most cases, these programs run

in the background all the time, but if you prefer, you can run them
manually when you get curious about your Mac’s current state. I
provide a list of several such utilities just ahead. But first, you should
understand what information you might want to monitor and why.

RAM usage

Mac OS X manages your computer’s RAM efficiently for the most
part. Applications can dynamically adjust the amount of memory
they use, and even if all your RAM is actively in use, a virtual memory
system lets Mac OS X use a portion of your hard disk to extend your
RAM, automatically swapping (or “paging”) data between the disk
and the physical RAM as needed.

Even so, if you have enough applications open at once, and if they
require enough memory to perform their respective tasks, you can
get to a point where the data swapping occurs constantly. This slows
everything on your Mac way down, and it also uses up disk space.

You should also be aware of a type of bug known as a memory leak.
Applications usually ask the system for a certain amount of memory
for any given task and then give it back when they’re done with it. But
sometimes, due to a programming error, an application keeps taking
memory and not returning any, so that by doing nothing more than
staying open, it constantly chews up more and more RAM. You can
recover the used memory simply by quitting the application—but you
might never know you have this problem in the first place without
monitoring your RAM usage.

For all these reasons, I recommend keeping an eye on how much
RAM is currently in use. If the free RAM drops near zero, consider
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closing windows, quitting applications, or even restarting your Mac
to reduce your dependence on virtual memory. Better yet, add more
RAM (if possible); see the sidebar Be Sure You Have Enough RAM,

earlier.

NoTE In Mac OS X, RAM is not simply “used” or “free” but can be used
in any of three different ways: wired (in use and crucial to keep your
Mac running); active (in use now, but may be paged out to disk
later); or inactive (not currently in use, and possibly paged out to
disk, but also stored in RAM for fast access when needed). Most
RAM-monitoring utilities break down RAM into these three catego-
ries plus “free,” and generally include documentation that explains
RAM usage in greater detail.

Disk usage

With hard disk capacity constantly on the rise, you're now less likely
to run out of space than you were a few years ago. Nevertheless, the
consequences of running out of space can be severe. For one thing, as
your hard disk approaches its maximum capacity, your Mac may run
more slowly as files become increasingly fragmented (see Defragment
Your Hard Disk). Worse, you could lose data, because your Mac has
no space to save a file. And even more seriously, your computer may
hang, crash, or fail to start up if it runs out of physical RAM and runs
out of disk space to use for virtual memory.

In general, I recommend leaving at least 10 to 15 percent of your hard
disk space empty to provide breathing room for file storage, virtual
memory, disk image creation, and other tasks. When your disk gets
close to that level, delete unneeded files (see the sidebar just ahead,
“Deciding Which Files to Delete”), and archive seldom-used files to
CD, DVD, or an external hard drive.

Although you can tell how much free space is on a disk by selecting

it in the Finder and choosing File > Get Info, you may not notice if

it gets dangerously full while you’re busy working. (Mac OS X does
display a warning message when space gets critically low, but it
appears much too late for my taste.) Several utilities display a live
status indicator (in your menu bar, a Dock icon, or a floating window)
showing your disks’ current free space.
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SIDEBAR DECIDING WHICH FILES TO DELETE

If you're running desperately low on disk space, it may be time to
buy a larger hard drive. In the meantime, you can delete files you no
longer need. Begin by repeating the procedure in Clean Out Accumu-
lated Cruft. If that still leaves you with too little free space and you're
stuck for ideas, try removing these items:

« Cache files: Mac OS X automatically re-creates these if needed,
so feel free to trash the contents of /Library/Caches and
~/Library/Caches.

« Downloads: Do you hang onto installers or other downloaded
files that you could simply download again if needed? If so, out
they go.

« Classic resources: If (and only if) you never use Mac OS X’s
Classic environment, you can get rid of the Mac OS 9 System
Folder (but not the folder named System, which belongs to Mac
OS X!) and Classic applications (usually stored in a folder called
“Applications (Mac OS 9)”).

« Developer tools: If you installed Apple’s Xcode Tools but aren’t
developing any software, remove the Developer folder at the top
level of your hard disk. The proper way to do this is to double-click
the file /Developer/Tools/uninstall-devtools.pl.

« Re-rippable music: As a last resort, look in ~/Music/iTunes/
iTunes Music for music you still have on CD (and which,
therefore, you can reimport). Be careful not to trash music you
purchased from the iTunes Music Store!

When you're finished deleting files, don’t forget to empty the Trash
(Finder > Empty Trash) to free up the space formerly occupied by
those files.

CPU load

Your Mac contains one or more CPUs—chips that do the bulk of

the computer’s information processing. Depending on what software
is running and what that software is doing, the CPU load goes up and
down. Because all your applications share the available CPU power,
it’s generally true that the higher the overall load, the slower your
software will run. In addition, greater CPU load means a higher
internal temperature, forcing your computer’s fans to work harder
(see Temperatures, next).
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Having your CPU(s) run at 100 percent capacity from time to time
is normal. However, if the load is always at or near maximum—or
if it’s high even when your computer is relatively inactive—you may
have a problem. For example, a background application could have
a bug that causes it to use too much processor capacity, slowing down
your foreground tasks. Or you may be running more applications
than your hardware can handle gracefully. In any case, keeping an
eye on CPU usage can help you spot potential problems before they
get out of hand. Some CPU monitoring tools display a breakdown
of usage by application, so that if one program is hogging too much
of the CPU capacity, you can force it to quit.

Temperatures

Extreme heat can damage delicate components inside your Mac. This
is why all Macs have carefully designed cooling systems, which usual-
ly rely on two or more fans to vent heat away from the processor, hard
drive, and other vital components. These fans, in turn, rely on one or
more internal temperature sensors that tell them when to turn on or
off or to increase or decrease speed.

If a fan malfunctions, if dust blocks the flow of air through your
computer (see De-Dust Your Mac), or if a defect in your computer
causes it to overheat for some reason, bad things can happen. Your
Mac may hang, shut down unexpectedly, or display other improper
behavior. Depending on the nature and severity of the problem, you
might be looking at an intermittent inconvenience or an expensive
trip to the repair shop. In any case, it behooves you to be alert to
excessive temperatures.

Several utilities monitor each of your computer’s internal tempera-
ture sensors, so that you can easily see when heat exceeds safe limits
and take action before damage occurs.

NoTE The types, positions, and design of temperature sensors vary from

one Mac model to the next. Not all Macs’ sensors work with
monitoring utilities or provide live updates of their readings.
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Other statistics

Some utilities monitor other statistics that may be interesting (though
not necessarily relevant to your Mac’s health). These include:

o Network traffic

« Disk access activity

« Battery level (for portables)

« System uptime (time since the computer was last turned on or

r

estarted)

Monitoring utilities
Although this is by no means an exhaustive list, the following utilities
all provide one or more monitoring services:

« Activity Monitor: This utility, included as part of Mac OS X (in
/Applications/Utilities) displays CPU load, RAM usage,
disk activity and usage, and network traffic (see Figure 10).

FIGURE 10
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Activity Monitor also displays memory and CPU usage statistics
for each running application, and enables you to quit individual
applications. Although it includes an optional floating CPU
window, Activity Monitor is not the best choice for background
operation.
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Amnesia: This tiny application displays current CPU load and
free memory (only) in its Dock icon.
http://dockapp-osx.sourceforge.net/dockapps.html (free)

App Monitor: If you want to keep an eye on the CPU usage
of one application at a time, try App Monitor, which displays
a customizable usage graph in either a window or a Dock icon.
http://blazingmousesoft.free.fr/AppMonitor.html (free)

Hardware Monitor: This utility can display a wide variety of
statistics in your menu bar, a Dock icon, or several other formats.
Information includes heat sensor readings, power supply voltage
and current, fan speeds (in RPM), battery level, and other data,
depending on your Mac model.
http://www.bresink.com/osx/HardwareMonitor.html (€7)

Mac HelpMate: In addition to performing many maintenance
tasks, this utility displays free RAM, internal temperature read-
ings, disk usage, S.M.A.R.T. status, and system uptime.
http://www.macworkshops.com/machelpmate/ (free; donations
accepted)

MemoryStick: This simple utility from Take Control’s own Matt
Neuburg displays a floating bar graph showing your current RAM
usage.

http://www.tidbits.com/matt/ (free)

Memory Usage Getter: Somewhat like Activity Monitor, this
utility displays overall RAM usage, plus per-application RAM
and CPU usage, and enables you to quit individual applications.
http://homepage.mac.com/simx/mug.html ($10)

MenuMeters: My favorite of the group, MenuMeters
(Figure 11), adds tiny, customizable indicators to your menu
bar to display any or all of the following: CPU load, RAM usage,
disk access activity (with usage on a drop-down menu), and
network traffic.
http://www.ragingmenace.com/software/menumeters/ (free)
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FIGURE 11

Dz o3 7 B = 4) % | MenuMeters can display

RAM and CPU usage, as
well as numerous other
bits of information, in
highly configurable
menus.

Open Activity Monitor
Open Console

miniStat: For Dashboard fans, this collection of six widgets
displays CPU load, free RAM, free disk space, CPU temperature,
battery level, and system uptime.
http://shockwidgets.com/?widget=miniStat (free)

SysStat: Another Dashboard widget, SysStat displays a single
panel with the following information: CPU load, RAM usage,
network traffic (and bandwidth), disk usage, battery level, and
system uptime.

http://www.islayer.net/viewWidget.php?id=7 (free)

Temperature Monitor: This application displays readings from
your Mac’s internal heat sensors, and even produces a graph of the
temperatures over time.
http://www.bresink.de/osx/TemperatureMonitor.html (free)

ThermographX: This utility displays the readings of all internal
heat sensors in your Mac and even keeps a graph of the tempera-
ture over time. But it’s not compatible with every Mac model.
http://www.kezer.net/thermographx.html ($7)

X Resource Graph: XRG provides highly customizable graphs
of CPU usage, RAM usage, disk access activity, network traffic,
internal heat sensors (up to three), and battery level, plus the
weather (in a city of your choice) and even stock market data.
http://www.gauchosoft.com/Software/ResourceGraph/ (free)
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Check Your Drives’ S.M.A.R.T. Status

Most modern hard drives have built-in sensors and monitoring
circuitry that form a system called S.M.A.R.T. (Self-Monitoring
Analysis and Reporting Technology). The idea of S.M.A.R.T. is to
detect the warning signs of potential problems before they occur.
Although S.M.A.R.T. cannot detect every possible drive problem, it
can provide one very valuable warning: “Your drive is about to have
problems, so back it up and repair (or replace) it now!”

NOTE As of early 2006, Disk Utility’s S.M.A.R.T. indicator works with
internal ATA and Serial ATA drives, but not with external (USB or
FireWire) drives. Some external drives, however, have their own
built-in S.M.A.R.T. indicators.

To check your drives’ S.M.A.R.T. status, open Disk Utility (in
/Applications/Utilities) and select a drive in the list on the
left. If the selected drive supports S.M.A.R.T., you should see this at
the bottom of the window: “S.M.A.R.T. Status: Verified” (Figure 12).
If you see “About to Fail” in red letters, back up the drive immedi-
ately. You can then use Disk Utility (or a third-party repair utility)

to attempt to repair the drive, but more often than not, “About to
Fail” indicates an imminent hardware failure that you cannot fix with
software. Even if Disk Utility does appear to solve the problem, don’t
trust the drive with important data; replace it as soon as possible.

Tip To monitor your drives’ S.M.A.R.T. status in the background
(without having to remember to open Disk Utility), try the free utility
SMARTReporter (http://homepage.mac.com/julianmayer/), which
displays a status icon in your menu bar.
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FIGURE 12
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APPENDIX A: TROUBLESHOOTING RESOURCES

I wish I could promise you that by following the suggestions in this
ebook, you’ll never experience any problems with your Mac. You will
lessen the likelihood and perhaps the severity of problems, but things
still can and will go wrong. If, when an application crashes, your hard
disk won’t mount or smoke starts pouring out of your SuperDrive,
you need more help than I can give you here. But allow me to suggest
some places you might look for solutions.

Web sites:

Apple’s support site: Your first stop should be Apple’s official
support site, where you can search for FAQs, technical notes, and
downloads that may address your problem.
http://www.apple.com/support/

Apple’s discussion forums: Another Mac user may have
discovered, and solved, a similar problem. Connect with other
users at these forums.

http://discussions.apple.com/

MacFixIt: Check the MacFixIt site daily for information about
newly identified problems and solutions for all sorts of Mac
hardware and software. (See the coupon near the back of this
ebook for a discount off the MacFixIt Pro premium service.)
http://www.macfixit.com/

MacInTouch: Keep current with Mac news and real-world
reports from users around the world.
http://www.macintouch.com/

MacOSXHints: This site is geared more toward tips and tricks
than troubleshooting, but it does contain solutions to many
unusual problems as well.

http://www.macosxhints.com/

Software update sites: VersionTracker and MacUpdate provide
up-to-the-minute info on updates for thousands of applications,
along with user comments. (See the coupon near the back of this
ebook for a discounted VersionTracker Pro subscription.)
http://www.versiontracker.com/

http://www.macupdate.com/
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Printed books:

« Mac OS X Help Line, Tiger Edition by Ted Landau and Dan Frakes
contains a wealth of troubleshooting and repair information.
http://www.amazon.com/gp/product/0321334299/ ($50 retail;
Amazon.com price, $33)

Ebooks:

« Troubleshooting Mac OS X by “Dr. Smoke” (Gregory A. Swain) is
a 600-page ebook that goes into great detail about solving a wide
variety of Mac problems.
http://www.thexlab.com/book/troubleshootingmacosx.html

($20)

When all else fails:

 Visit the Genius Bar at a nearby Apple Store for free advice; Apple
Stores also offer expert repair services. Be sure to call ahead (or
visit the store’s Web site) to make an appointment.

« If you’re not near an Apple Store, search for an Apple Authorized
Service Provider at http://www.apple.com/buy/locator/
service.html.

Page 79


http://www.amazon.com/gp/product/0321334299/
http://www.thexlab.com/book/troubleshootingmacosx.html
http://www.apple.com/buy/locator/service.html
http://www.apple.com/buy/locator/service.html

PERIODIC TASK CHECKLIST

Print this page and hang it in a conspicuous place to remind you which tasks
you should do when. You might also consider adding daily, weekly, monthly,
and yearly reminders to your favorite calendar application.

Daily Tasks

Q Back up changed files. O Download (but don't install)
software updates.

Weekly Tasks

O Clean up your Desktop. Q Check for third-party software

QBack up everything. updates.

QO Rotate backups offsite. O Reboot if performance seems slow.

0 Use Software Update to O Consider clearing certain caches.

install Apple software updates.

Monthly Tasks

O Empty your Trash. a Clean your mouse or trackball.
O Use Disk Utility’s Repair Disk O Exercise your notebook’s battery.
feature.

Q Check for Take Control updates.
Q Clean your screen.

Yearly Tasks

O De-dust your Mac. O Make archival backups to DVD.
A Clean your keyboard. O Remove unneeded files.
a Clean your iSight. d Change your passwords.
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FEATURED TITLES

Now that you’ve seen this ebook, you know the Take Control ebooks have great
onscreen layout, clickable links, and real-world info that puts you in control. Click
any book image below or visit our Web store to add to your ebook collection!

Take Control
of Upgrading
to Tiger
by Joe Kissell
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Enjoy expert guidance as
you install Tiger. Learn the
seven steps necessary
before installing and how
to successfully complete
your upgrade.

$5

Take Control of
Users & Accounts
in Tiger
by Kirk McElhearn
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° Ugers &
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in Tiger

Create the right accounts
for your Mac, even if
you're the only one who
uses it, use Fast User
Switching, and more!

$5
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of Customizing
Tiger
by Matt Neuburg
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Find real-world advice in
this road map to
customizing Tiger, plus
get started with new fea-
tures, such as Spotlight
and Automator.

$5

Take Control
of Making Music

with GarageBand
by Jeff Tolbert

Take Control
o Making
Music with
GarageBand

Combine your creativity
with GarageBand'’s
editing and mixing

techniques to compose

tunes that please the ear!
$10
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of Mac OS X
Backups
by Joe Kissell

Backups
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Create a rock-solid
backup strategy so you
can restore quickly and
completely, no matter
what the catastrophe.

$10

More Titles!

Delve into even
more topics, including:

e Running your Mac—
working with permissions
and sharing files.

e Buying gear—Macs,
cameras, and digital TVs.

e More topics—.Mac, AirPort
and Wi-Fi security, email,
spam, podcasting, and
Microsoft Office.
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Be your own Mac Guru

Make sure you have all of the information you need to keep your Mac current and operating
at its peak with a subscription to VersionTracker Pro and MacFixIt Pro. Take Control readers
can save up to $15 when they follow the link on this page!
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VersionTracker Pro is like Software Update
for all of the apps on your Mac (not just the
Apple ones).

aase

& L

Downlvad

Lists
© Available Updates

w0 watch Lists
£ Mert Lin

W New Softwa
A Search Resu

\_’ﬂ;l;mTli(I:!r Pro v4.0.1 =]

o @ o5 T

Ship Varsian Inapect - Chack For Updatey Rapoet Search Version Tracker

oL Mame Wy Veron & Currer

L??F‘Wf?“”“u:‘m‘if."““”?‘u;#—.=\m

® Adabe lllustrator C5 11 2.1 -
# Adobe Photothep C5 .0 wo

s 2 Adobe Reader 6.0 6.0 16.0.0 7.07
e ¥ AppZapper 110 113

Camera Raw 0110 i3

& €D Spin Doctor 2 102

@ Discus RE2.74 LTALTA a0pr

@ Drearmweaver MX 2004 Tol2e1 8ol

F OropStuff 13 10.0

W Feich 4.0.3 L 5.1b2

B8 Final Cut Express 1.0.1 Lil 5.0

&) Final Cut Express HO 0 101

@ rirefox 5 1.5.0.1

@ rash mx 20

Adobe Acrobat 7.0.7 - _ m
Category, Internat Utilities

create & edit POF files

Developer, Adobe Systems Incorporated
Path: /Applications | Adobe Acrobat
7.0 Standard/ Adobe Acrobar 7.0

Standard.app

Develaper Page. Product Info

License. Update

Product Description Release Date:  2006-02-08
6,201

255,465

Whether files need to be shared across  Downloads v7.0.7)
the office or around the glabe. the

Adobe Acrobat oroduct family enables Exatniosds ol

e Track the installed software on up to 3
Macs with the VersionTracker Pro soft-
ware, and download updates with a
single click.

e Customize the VersionTracker website:
turn off ads, download with a single
click, set unlimited product alerts.

e Generate, download and print reports
comparing all your computers monitored
by Version Tracker Pro.

MacFbItPro

Every day, the MacFixIt editorial staff helps
thousands of Mac users find solutions and
workarounds to problems with OS X, Mac
hardware and software, and third-party
apps as they arise.

Subscribe to MacFixIt Pro, and access the
entire database of Mac troubleshooting in-
formation, including:

e Comprehensive Troubleshooting Reports
on OS, hardware, and software releases

e Tutorials to help you master the details
of OS X, minimize hardware conflicts
and diagnose problems yourself

e Mac Musings: an exclusive monthly
column from Ted Landau, author of
Mac OS X Help Line.

In addition, you can turn off all ads on the
website, use the Advanced Search tool, and
use your subscriber login to participate in
the MacFixIt Forums, a community of Mac
users with a focus on keeping their Macs
(and yours) running at peak shape.

The deal: readers of this ebook can save
up to $15 off the regular price of a com-
bined subscription to these two essential
tools by clicking on the button below.
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information you need to keep your Mac
current!
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What do you get when you buy

from Small Dog Electronics?

—

service selection alue small dogs!

Now, °5 off your next web order!

small Dog Electroni
: something to smile about...

Redeem your coupon on-line at
small nog www.smalldog.com Limited to one
e use per customer. Enter coupon #
HCCII'OIIICS bone88810067 atcheck out.
www.smalldog.com

& Apple Specialist 1-800-511-MACS

We measure success in more than just dollars.
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